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1. Wstęp
Niniejsza dokumentacja opisuje oprogramowanie TEX Live – dystrybucję TEX-a/LATEX-a dla systemów
Linux, różnych wersji Unix (w tym Mac OS X) oraz Windows. (Uwaga: dystrybucja jest mało przydatna
dla starszych systemów Mac i MS-DOS.) TEX Live zawiera skompilowane programy TEX, LATEX 2ε,
METAFONT, METAPOST, BibTEX i wiele innych oraz bogaty zestaw pakietów makr o wielorakim
zastosowaniu, a także fonty i dokumentacje, umożliwiające skład publikacji w wielu językach.

Nie opisujemy tu, co to jest system TEX, a jedynie kwestie instalacji i konfiguracji oprogramowania
TEX Live. Początkujący użytkownicy mogą zapoznać się z podstawowymi pojęciami w artykule
Przewodnik po systemie TEX texmf/doc/html/polish/cototex.html.

Ostatnia aktualizacja oprogramowania dla tegorocznej edycji (2003) TEX Live została dokonana
3 września. Nowsze wersje pakietów można znaleźć na serwerach CTAN, http://www.ctan.org.

Lista najważniejszych zmian, jakie dokonano w tej edycji TEX Live znajduje się w części 9.2 na
str. 48.

1.1. Podstawy użycia TEX Live
Z TEX Live można korzystać na co najmniej trzy sposoby:

1. uruchomiać wszystkie programy bezpośrednio z płytki (nie dotyczy to dystrybucji inst; patrz
rozdział 2.1 na str. 4); na dysku twardym znajdą się jedynie niezbędne pliki konfiguracyjne
i chociaż wydajność będzie mniejsza niż w wypadku instalacji na twardym dysku, instalacja taka
jest w pełni funkcjonalna.

2. zainstalować część lub cały system na lokalnym twardym dysku; jest to najczęstsze wykorzystanie
TEX Live; wymagane jest co najmniej 120 megabajtów, ok. 360 megabajtów dla instalacji zalecanej
i ok. 800 megabajtów dla instalacji kompletnej;

3. doinstalować wybrane pakiety do istniejącego systemu TEX lub systemu TEX Live instalowanego
wcześniej.

Szczegóły procedur instalacyjnych podane zostaną dalej w rozdziałach poświęconych konkretnym
systemom operacyjnym.

file:../../../../texmf/doc/html/polish/cototex.html
http://www.ctan.org
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1.2. Dostępna pomoc
Społeczność TEX-owa jest bardzo aktywna i pomocna, stąd też większość poważnych pytań nie
zostanie pozostawiona bez odpowiedzi. Przed zadaniem pytania warto je uprzednio dobrze przemyśleć
i sformułować, ponieważ respondenci to wolontariusze, wśród których znaleźć się mogą mniej lub
bardziej doświadczeni użytkownicy. (Jeśli preferujemy komercyjne wsparcie techniczne, możemy zamiast
TEX Live zakupić system u jednego z dostawców, których listę znaleźć można na http://tug.org/
interest.html#vendors.)

Oto lista źródeł pomocy, w kolejności, w jakiej ją rekomendujemy:

TEX FAQ TEX-owy FAQ jest obszernym zbiorem odpowiedzi na wszelkie rodzaje pytań, od najprostszych
do najbardziej zaawansowanych. Jest on załączony na TEX Live w FAQ/english, a także dostępny
w sieci: http://faq.tug.org. Proponujemy tam najpierw zajrzeć. Od niedawna uruchomiono
też serwis FAQ w języku polskim: http://faq.gust.org.pl.

TEX Catalogue Jeśli poszukujemy konkretnego pakietu, fontu, programu itp., polecamy TEX Catalogue.
Jest to obszerne zestawienie wszelkich tematów dotyczących TEX-a. Patrz texmf/doc/html/
catalogue lub http://www.ctan.org/tex-archive/help/Catalogue/catalogue.html.

archiwa pomocy Dwa główne forum pomocy to Usenet newsgroup news:comp.text.tex oraz lista
dyskusyjna texhax@tug.org. Warto przeszukać archiwa list dyskusyjnych zawierające tysiące
pytań i odpowiedzi zbieranych przez wiele lat; odpowiednio http://groups.google.com/
groups?group=comp.text.tex oraz http://tug.org/mail-archives/texhax. Nie zaszko-
dzi skorzystanie z ogólnego serwisu web, np. http://google.com.

wysyłanie pytań Jeśli nadal nie znajdujemy rozwiązania problemu, możemy wysłać pytanie do comp.
text.tex korzystając z Google, czytnika wiadomości bądź pisząc list na adres texhax@tug.org.
Przedtem jednak należy zapoznać się z radami dotyczącymi sposobu zadawania pytań, zawar-
tymi w FAQ: http://www.tex.ac.uk/cgi-bin/texfaq2html?label=askquestion. Polscy
użytkownicy mają do dyspozycji listę dyskusyjną GUST (Grupy Użytkowników Systemu TEX);
informacje znajdziemy na stronie http://www.gust.org.pl.

wsparcie TEX Live Gdy chcemy zgłosić błąd bądź sugestie i komentarze dotyczące dystrybucji TEX
Live, instalacji lub dokumentacji, mamy do dyspozycji listę dyskusyjną tex-live@tug.org. Gdy
kwestia dotyczy konkretnego programu (pakietu makr itp.) zawartego na TEX Live, lepiej jednak
skierować pytanie do osoby pielęgnującej ten program lub na specjalistyczną listę dyskusyjną.

Druga strona medalu to pomaganie tym, którzy mają problemy. Zarówno comp.text.tex, jak
i texhax (oraz lista dyskusyjna GUST) są otwarte dla każdego, a więc zapraszamy do włączenia się,
czytania wiadomości i pomagania innym w miarę własnych możliwości. Witamy wśród użytkowników
systemu TEX!

2. Struktura TEX Live
Dwa główne skrypty instalacyjne dla systemów Unix i Mac OS X to install-tl.sh oraz
install-pkg.sh. Zostaną one szerzej omówione w rozdziale 3 na str. 9. Tutaj omówimy strukturę
i zawartość dystrybucji TEX Live.

2.1. Rozmaitość dystrybucji: live, inst, demo
W 2003 roku limit pojemności formatu CD-ROM zmusił nas do opublikowania TEX Live w trzech
następujących dystrybucjach:

http://tug.org/interest.html#vendors
http://tug.org/interest.html#vendors
http://faq.tug.org
http://faq.gust.org.pl
http://www.ctan.org/tex-archive/help/Catalogue/catalogue.html
news:comp.text.tex
mailto:texhax@tug.org
http://groups.google.com/groups?group=comp.text.tex
http://groups.google.com/groups?group=comp.text.tex
http://tug.org/mail-archives/texhax
http://google.com
mailto:texhax@tug.org
http://www.tex.ac.uk/cgi-bin/texfaq2html?label=askquestion
http://www.gust.org.pl
mailto:tex-live@tug.org
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live kompletny, także uruchamialny bezpośrednio z nośnika, system na DVD (zbyt obszerny aby się
zmieścił na CD-ROM); płytka zawiera ponadto zrzut zawartości archiwów CTAN, niezależny od
TEX Live;

inst(alowany) kompletny system na CD-ROM-ie, gdzie wszystkie pakiety zostały skompresowane; płytka
ta nie nadaje się do bezpośredniego uruchamiania programów, a jedynie instalacji na twardym
dysku;

demo dystrybucja na CD-ROM-ie, pozwalająca zarówno na uruchamianie bezpośrednio z nośnika,
jak i zainstalowanie na dysku; wersja ta jest nieco uboższa od wersji pełnej: brak tu bardzo
obszernego zestawu CJK (wsparcie dla języków: chińskiego, japońskiego i koreańskiego) oraz
równie obszernych pakietów rzadziej używanych fontów (cm-super i cbtype1), znajdziemy tu
jedynie programy dla systemów Linux, MacOSX i Windows.

Poszczególne dystrybucje są rozpoznawalne po nazwie pliku 00typ.TL, który znajdziemy w głównym
katalogu płytki.

2.2. Główne katalogi
Poniżej wymieniono ważniejsze podkatalogi głównego katalogu CD-ROM/DVD.

Books pliki przykładów z różnych książek poświęconych systemowi TEX.

FAQ najczęściej zadawane pytania, w wersji angielskiej, francuskiej i niemieckiej;

MacOSX programy pomocnicze dla użytkowników MacOSX (patrz część 4 na str. 15);

bin wykonywalne programy TEX-owe, rozdzielone w katalogach według platform systemowych;

info dokumentacja w formacie GNU „info” dla systemu TEX;

man dokumentacja w formacie uniksowych stron „man” dla systemu TEX;

source źródła wszystkich programów, włącznie z głównymi dystrybucjami Web2C TEX-a i META-
FONT-a; są one umieszczone w skompresowanym programem bzip2 archiwum tar;

support różne programy związane z TEX-em, które nie są domyślnie instalowane, takie jak MusixTEX
i inne programy pomocnicze. Dla użytkowników systemów Windows dołączono ponadto szereg
programów (edytory, „shelle TeX-owe”), których zwykle brak w typowej instalacji Windows
(programy te mogą być przydatne szczególnie dla początkujących).

texmf główne drzewo katalogów z makrami, fontami i dokumentacją;

usergrps materiały dotyczące grup użytkowników systemu TEX (TEX User Groups).

xemtex zaawansowany edytor XEmacs i inne programy pomocnicze dla Windows (patrz część 5.3 na
str. 19). W systemach Unix programy te są zazwyczaj dostępne bądź łatwe do samodzielnego
skompilowania.

2.3. Rozszerzenia TEX-a
TEX Live zawiera trzy rozszerzenia standardowego TEX-a:

ε-TEX wersja programu TEX, która zawiera dodatkowo niewielki, lecz silny zestaw nowych poleceń
wbudowanych (dotyczących głównie rozwijania makr, leksemów znakowych, interpretacji znaczni-
ków itp.) oraz rozszerzenie TEX--XET dla składu od prawej do lewej. W trybie domyślnym ε-TEX
jest w 100% zgodny ze standardowym programem TEX. Więcej szczegółów znaleźć można na
CD-ROM-ie, w texmf/doc/etex/base/etex_man.pdf. Obecnie ε-TEX jest domyślnie stosowaną
„maszyną TEX-ową” dla formatu LATEX, zaś pdfε-TEX dla formatu pdfLATEX.
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pdfTEX program, który wynik składu może zapisywać zarówno w formacie Acrobat PDF, jak i DVI.
Podręcznik użytkownika znajduje się w pliku texmf/doc/pdftex/pdftex-l.pdf. Plik texmf/
doc/pdftex/base/example.tex pokazuje przykład wykorzystania. LATEX-owy pakiet hyperref
posiada opcję „pdftex”, która uaktywnia dostęp do wszystkich cech programu.

Ω (Omega) program, który pracuje wewnętrznie ze znakami kodowanymi 16-bitowo (Unicode); pozwala
pracować jednocześnie z większością tekstów spotykanych na świecie. Wspomaga także dynamicz-
nie ładowane tzw. „procesy tłumaczenia Ω” (OTP), co pozwala użytkownikowi definiować złożone
transformacje wykonywane na dowolnych strumieniach wejściowych. Więcej szczegółów znaleźć
można na CD-ROM-ie: texmf/doc/omega/base/doc-1.8.tex (dokumentacja niezbyt aktualna).

2.4. Inne ważniejsze programy TEX Live
Poniżej zestawiono inne najczęściej używane programy dostępne w dystrybucji TEX Live:

bibtex tworzenie spisów bibliograficznych;

makeindex tworzenie posortowanych skorowidzów;

dvips konwersja DVI do PostScript;

xdvi przeglądarka plików DVI dla X Window;

dvilj sterownik dla drukarek HP LaserJet;

dv2dt, dt2dv konwerter DVI do/z tekstu ASCII;

dviconcat, dviselect programy do manipulacji stronami w plikach DVI;

dvipdfm konwersja DVI do PDF, alternatywna metoda w stosunku do wspomnianego wyżej programu
pdfTEX (pakiety ps4pdf i pdftricks dostarczają kolejnych możliwości);

psselect, psnup, . . . narzędzia manipulacja na plikach PostScript-owych;

lacheck kontrola syntaktyki plików LATEX-owych;

texexec program uruchomieniowy dla ConTEXt;

tex4ht konwerter TEX do HTML.

2.5. Pakiety i ich zestawy
Zawartość drzewa texmf na TEX Live została do celów instalacji zorganizowana w szereg „zestawów”
(collections), z których każdy posiada zbiór „pakietów” (packages; jest ich ponad 800). Normalna
instalacja pozwala użytkownikowi skopiować z CD-ROM-u (DVD) na twardy dysk jeden lub więcej
zestawów, jest też jednak możliwe zainstalowanie tylko jednego pakietu.

Zestawy pozwalają lepiej dobrać instalowane składniki, a także określić, jakie języki będą ob-
sługiwane po instalacji. Najważniejszy zestaw, wymagany dla większości zastosowań, to „tex-basic”.
Zestawy „tex-latex” i „tex-pdftex” są rekomendowane dla większości użytkowników. Pozostałe ze-
stawy są opcjonalne. Dostępne zestawy (zdefiniowane w plikach XML umieszczonych w katalogu
texmf/tpm/collection) i krótki opis ich zawartości:

tex-basic podstawowe programy, pakiety makr i fontów systemu TEX; pliki konfiguracyjne dla podsta-
wowych sterowników;

tex-bibtexextra dodatkowa, obszerna biblioteka stylów BibTEXowych i bazy danych bibliograficznych
(podstawowe style znajdują się w zestawie „basic”);

tex-chemistry pakiety makr do składu formuł chemicznych;

tex-context pakiet makr do „dialektu” TEX-a, ConTEXt, autorstwa Hansa Hagena;

file:../../../../texmf/doc/pdftex/base/example.tex
file:../../../../texmf/doc/pdftex/base/example.tex
file:../../../../texmf/doc/omega/base/doc-1.8.tex


2 STRUKTURA TEX Live 7

tex-documentation dodatkowe, użyteczne dokumentacje;

tex-etex pomocnicze pliki dla programu e-TEX;

tex-extrabin różne programy pomocnicze; zestaw zawiera m.in. programy i makra dla systemu texinfo,
programy do manipulacji na plikach DVI itp.;

tex-fontbin programy konwersji plików fontowych i do testowania oraz instalacji fontów (zestaw do
tworzenia fontów wirtualnych, manipulacji z plikami .gf i .pk, programy mft, fontinst itp.);

tex-fontsrecommended obszerna biblioteka częściej używanych fontów w postaci źródłowej .mf bądź
obwiedniowych oraz pliki definicyjne i stylów LATEX-a dla tych fontów;

tex-fontsextra biblioteka różnych fontów rzadziej używanych;

tex-formatsextra pliki pomocnicze do generowania dodatkowych „formatów” (tj. obszerne zestawy makr
służące do wstępnego przetworzenia i utworzenia pliku .fmt);

tex-games pakiety do prezentacji zapisu różnych gier (szachy, brydż itp.);

tex-genericextra obszerna biblioteka makr, trudnych do sklasyfikowania, działających z różnymi
formatami (Plain, LaTeX itp.);

tex-htmlxml pakiety konwersji LATEXa do XML/HTML oraz do składu dokumentów XML/SGML;

tex-langafrican wsparcie dla niektórych języków afrykańskich;

tex-langarmenian armeński;

tex-langcjk pakiety CJK (obsługa chińskiego, japońskiego i koreańskiego);

tex-langcroatian chorwacki;

tex-langcyrillic fonty i makra do składu cyrylicą;

tex-langczechslovak fonty i pakiety makr dla czeskiego i słowackiego;

tex-langdanish duński;

tex-langdutch holenderski;

tex-langfinnish fiński;

tex-langfrench francuski;

tex-langgerman niemiecki;

tex-langgreek grecki;

tex-langhungarian węgierski;

tex-langindic wsparcie dla języków indyjskich;

tex-langitalian włoski;

tex-langlatin łacina;

tex-langmanju język Manju;

tex-langmongolian mongolski;

tex-langnorwegian norweski;
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tex-langother wzorce przenoszenia wyrazów dla innych języków;

tex-langpolish polskie pakiety: makra do tworzenia formatu MeX, pakiety platex, mwcls, fonty, makra
dodatkowe, przydatne dla polskich użytkowników, dokumentacje w języku polskim;

tex-langportuguese portugalski;

tex-langspanish hiszpański;

tex-langswedish szwedzki;

tex-langtibetan fonty i wsparcie do składu tybetańskiego;

tex-langukenglish angielski (brytyjski);

tex-langvietnamese wietnamski;

tex-latex podstawowe pakiety LATEXa;

tex-latexrecommended rekomendowany, często używany zestaw pakietów dodatkowych;

tex-latex3 pakiety-„zwiastuny” LATEX3, działające z LATEX 2ε;

tex-latexextra bogaty wybór dodatkowych pakietów dla LATEX-a;

tex-mathextra dodatkowe pakiety do składu zaawansowanej matematyki;

tex-metapost MetaPost i pakiety do tworzenia rysunków z użyciem MetaFonta;

tex-music makra do sładu nutowego;

tex-omega rozszerzenie TEXa, Omega, działające ze znakami kodowanymi 16-bitowo, autorstwa Johna
Plaice’a i Yannisa Haralambousa;

tex-pdftex pomocnicze pliki dla pdfTEXa, wersji programu TEX tworzącej pliki w formacie PDF;

tex-pictures pakiety do tworzenia diagramów i innych obiektów graficznych;

tex-plainextra dodatkowe biblioteki makr dla Plain;

tex-psutils narzędzia do manipulacji z plikami PostScript-owymi;

tex-publishers pakiety makr pochodzące od różnych wydawnictw;

tex-t1utils narzędzia do fontów w formacie Type 1;

tex-texbooks przykłady i inne materiały D.E. Knutha;

tex-ttfutils narzędzia do konwersji fontów True Type;

tex-xemacs dodatkowe programy wspomagające dla Windows (zaawansowany edytor XEmacs – zinte-
growane środowisko do pracy z TEXem, Perl, programy konwersji grafiki, itp.);

Katalog texmf/tpm/package (wykorzystywany podczas instalacji) zawiera spis wszystkich plików
w każdym pakiecie.
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Uwaga: CD-ROM-y i DVD są w formacie ISO 9660 (High Sierra), z rozszerzeniami Rock Ridge
i Joliet. Aby skorzystać z wszystkich zalet płytki pod Unixem, twój system powinien obsługiwać
rozszerzenie Rock Ridge. Prosimy zapoznać się z dokumentacją komendy mount w twoim systemie
aby sprawdzić, czy to jest możliwe. Jeżeli używasz wielu różnych maszyn w sieci lokalnej zobacz,
czy możesz zamontować CD-ROM/DVD na tej, która pozwala na użycie Rock Ridge.

Systemy Linux, FreeBSD, Sun, SGI oraz DEC Alpha powinny umieć bez problemów korzystać
z CD-ROM-u/DVD. Będziemy wdzięczni za wszelkie wskazówki od użytkowników innych systemów,
którym udało się skorzystać z niniejszych płytek, z których to wskazówek moglibyśmy skorzystać
w przyszłych wersjach tej dokumentacji.

Dalsze kroki opisane są przy założeniu, że udało się zamontować CD-ROM/DVD w pełnej
zgodności z Rock Ridge.

3. Instalacja i użytkowanie w systemach Unix
Jak już wspomniano w części 1 na str. 3, TEX Live można używać na trzy sposoby:

1. zamontować (mount) CD-ROM w systemie plików, uruchomić skrypt install-tl.sh i wybrać
opcję <R> (do not install files, set up to run off CD-ROM/DVD – bez instalacji plików,
dostosuj do uruchamiania z CD-ROM-u/DVD). Pozwala to na uruchamianie wszystkich programów
bezpośrednio z płytki; na dysku twardym znajdą się jedynie niezbędne pliki konfiguracyjne.

2. zainstalować część lub cały system na lokalnym twardym dysku;

3. doinstalować wybrane pakiety do istniejącego systemu TEX lub systemu TEX Live instalowanego
wcześniej.

Każda z tych metod jest dokładniej opisana w dalszych rozdziałach.

3.1. Uruchamianie TEX Live z płytki (Unix)
Na CD-ROM-ie demo zawarto programy jedynie dla systemów Linux, Mac OS X oraz Windows. Aby
korzystać bezpośrednio z nośnika w innych systemach Unix należy użyć DVD.

Najpierw należy zamontować CD-ROM lub DVD – postać polecenia jest zależna od konkretnej
platformy, poniższe działa w Linux, choć nazwa urządzenia (tu /dev/cdrom) może się różnić.
W przykładach podajemy > jako znak zgłoszenia powłoki.

> mount -t iso9660 /dev/cdrom /mnt/cdrom

następnie zmieniamy katalog bieżący na katalog montowania:

> cd /mnt/cdrom

W systemie Mac OS X katalog ten znajduje się zwykle w ramach /Volumes zaś medium montowane jest
automatycznie.
Uruchamiamy skrypt instalacyjny install-tl.sh:

> sh install-tl.sh
Welcome to TeX Live...

Po ukazaniu się głównego menu mamy do wyboru kilka opcji wprowadzanych poprzez naciśnięcie
wybranego znaku oraz klawisza Enter (nie należy wpisywać znaków <>; duże i małe litery są tożsame,
w przykładach podajemy małe litery).

Dla uruchamiania bezpośrednio z płytki wybierzmy najpierw opcję d, następnie podopcję 1, która
pozwoli nam określić katalog na generowane przez TEX-a pliki (fonty, formaty, pliki konfiguracyjne
do modyfikacji ustawień). Jeśli odpowiadają nam ustawienia domyślne (/usr/TeX), możemy pominąć
poniższy fragment. W naszym przykładzie użyjemy /usr/local/texlocal:
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Enter command: d
Current directories setup:
<1> TEXDIR: /usr/TeX
...
Enter command: 1
New value for TEXDIR [/usr/TeX]: /usr/local/texlocal
...
Enter command: r

wciśnięcie klawisza r powoduje powrót do głównego menu, gdzie wybieramy opcję uruchamiania
bezpośrednio z nośnika, bez instalacji właściwej na dysku:

Enter command: r
Preparing destination directories...
...
Welcome to the TeX Live system!
>

Następnie należy uaktualnić zmienną PATH, dołączając do ścieżki przeszukiwania programów katalog
zawierający binaria dla danej architektury, a także ustawić zmienną VARTEXMF na podany powyżej katalog.
Dla powłoki zgodnej z Bourne shell (sh, bash, ksh) możemy dopisać do pliku $HOME/.profile:

PATH=/mnt/cdrom/bin/archname:$PATH; export PATH
VARTEXMF=/usr/local/texlocal; export VARTEXMF

gdzie archname oznacza konkretną platformą W tabeli zamieszczono spis obsługiwanych systemów
i odpowiednich nazw podkatalogów. Należy pamiętać, że demo CD-ROM zawiera jedynie binaria dla
Windows, Linux dla Intel i Mac OSX. Dla innych systemów Unix należy zastosować drugi CD-ROM bądź
DVD. W nazwie podkatalogu możemy pominąć numer wersji, np. sparc-solaris jest dowiązaniem do
sparc-solaris2.7.

Tabela 1: Obsługiwane systemy

alpha-linux Compaq Alpha Linux
i386-freebsd4.8 Intel x86 FreeBSD
i386-linux Intel x86 GNU/Linux demo CD-ROM
i386-openbsd3.3 Intel x86 OpenBSD
i386-solaris2.8 Intel x86 Solaris
mips-irix6.5 SGI IRIX
powerpc-aix4.3.3.0 IBM RS/6000 AIX
powerpc-darwin6.3 Mac OS X demo CD-ROM
sparc-solaris2.7 Sun Sparc Solaris
sparc64-linux Sun Sparc Linux
win32 Windows (32-bit) demo CD-ROM

Po ponownym uruchomieniu sesji polski użytkownik może użyć bezpośrednio m.in. polecenia
mex (TEX ze spolonizowanym formatem Plain), platex (LATEX z polskimi i anglo-amerykańskimi
wzorcami przenoszenia wyrazów) oraz ich wersje dla programu pdfTeX (tworzącego pliki PDF),
odpowiednio: pdfmex i pdfplatex. Potrzebne pliki formatów zostaną wygenerowane automatycznie
podczas pierwszego uruchomienia danego polecenia i zapisane w lokalnym katalogu. Katalog ten,
domyślnie /usr/TeX/texmf-var/, a w naszym przykładzie /usr/local/texlocal/texmf-var/
zawiera pliki konfiguracyjne, które mogą być modyfikowane przez użytkownika. W konfigurowaniu
pomocne jest uruchomienie skryptu texconfig, opisanego w części3.4, na str. 13.
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3.2. Instalacja TEX Live na twardym dysku
Instalacja części lub całości dystrybucji na twardym dysku wymaga zamontowania CD-ROM-u (lub DVD)
w systemie, przejścia do jego katalogu głównego i uruchomienia:

> sh install-tl.sh

(W niektórych systemach Unix może zajść potrzeba użycia sh5 lub bash.) Skrypt ten przeszukuje listy
zestawów i pakietów z CD-ROM-u oraz próbuje odgadnąć, z jakim systemem komputerowym ma do
czynienia.

Następnie pokaże główną stronę konfiguracyjną umożliwiającą wybór:

1. <P> systemu operacyjnego, dla którego chcemy dokonać instalacji (na wypadek gdy zawiedzie
automatyczna detekcja);

2. <B> dodatkowo instalowanych binariów dla innych platform (np. na serwerze, z którego będą
korzystać użytkownicy innych systemów);

3. <S> installation scheme (predefiniowanego zestawu instalacyjnego), np. full – pełnego, recom-
mended – zalecanego, basic – podstawowego; mamy tu też do wyboru zestaw proponowany dla
polskich użytkowników: GUST scheme;

4. zestawów, które mogą zmodyfikować wybrany schemat instalacji (są one zgrupowane w dwóch
kategoriach: <C> standard collections – zestawy standardowe oraz <L> language collections –
zestawy dla obsługiwanych języków);

5. <D> katalogu bazowego na dysku, przeznaczonego na instalację;

6. <O> ustawienia trybu pracy niektórych programów.

Opcje wybiera się przez wpisanie litery lub liczby i potwierdzenie jej klawiszem Enter. Przykładowo:
wykryty został system Linux dla platformy Intel x86, wybrane zostały predefiniowane zestawy, domyślny
katalog instalacji to /usr/TeX. Zauważmy, że wyświetlana jest także ilość miejsca na dysku, potrzebna do
zainstalowania pakietów. Jeśli wykonuje się sugerowaną instalację, potrzebne jest około 300 megabajtów
wolnego miejsca na dysku. Podstawowa instalacja zajmie jedynie 100 megabajtów; można ją poszerzyć
o wybrane pakiety, kiedy zajdzie taka potrzeba.

Użytkownicy MacOSX – dostępne programy instalacyjne (TeXShop, ITeXMac. . . ) stosują domyślną
lokalizację teTEX, czyli /usr/local/teTeX. Wobec czego użytkownicy Mac dla instalacji TEX
Live powinni rozważyć wybór katalogu /usr/local/teTeX zamiast /usr/TeX.

W katalogu wybranym do instalacji, w podkatalogu bin, skrypt instalacyjny umieści binaria. Drzewo
z plikami TEX-owymi zostanie umieszczone w podkatalogu texmf. Dodatkowy podkatalog texmf-var
będzie zawierał kopie plików konfiguracyjnych (prócz głównego texmf.cnf), które będą modyfikowane
podczas uruchamiania programu texconfig; znajdą się w tym katalogu także generowane pliki formatów.
Lokalne makra i fonty można będzie umieszczać w podkatalogu texmf-local – aktualizacja bądź
reinstalacja systemu TEX nie naruszy zawartości tego katalogu.

Po wybraniu opcji <C> – standard collections, wyświetlone zostaną dostępne zestawy. Każdy zestaw
zawiera szereg pakietów: makr, fontów itp. Zaznaczenie zestawu do zaistalowania polega na wciśnięciu
odpowiedniego klawisza; ponowne naciśnięcie tego samego klawisza wyłącza zaznaczenie (uwaga: duże
i małe litery są rozróżniane!).

Po wybraniu opcji <L> – language collections, wyświetlone zostaną dostępne zestawy dla różnych
języków. Zestawy zawierają najczęściej wzorce przenoszenia wyrazów, czasami dodatkowe pakiety makr
i fontów. Aby zainstalować polskie pakiety (fonty, makra, dokumentacje), należy w tym menu zaznaczyć
klawiszem v opcję Polish.
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Po powrocie do głównego menu można dodatkowo wybrać inne opcje. I tak: <O> options pozwala
zdecydować, czy nowo tworzone fonty powinny znaleźć się w innym miejscu (jeżeli chcemy, dla
większości użytkowników, zainstalować główny pakiet w trybie „tylko do odczytu” (read-only)), oraz
czy utworzyć dowiązania symbliczne (links) dla stron man i GNU info w standardowych katalogach
systemu. Wymagane do tego są, oczywiście, uprawnienia administratora.

Po zakończeniu ustawień, po powrocie go głównego menu, można rozpocząć instalację (klawisz I).
Program instalacyjny, uwzględniając wybrane zestawy i systemy, sprawdzi spisy plików na CD-ROM-ie,
stworzy listę plików do skopiowania, po czym pliki te zostaną skopiowane na twardy dysk. Następnie
uruchamiana jest sekwencja inicjująca (tworzenie plików formatów itd.). Po instalacji wystarczy dodać
do zmiennej PATH właściwy podkatalog bin instalacji TEX-a i można zacząć pracę. Jeśli zajdzie
potrzeba, można przenieść binaria wyżej o jeden poziom, np. z /usr/local/bin/i386-linux do
/usr/local/bin; jednakże po tym należy wyedytować plik texmf/web2c/texmf.cnf i zmienić linię
znajdującą się blisko początku pliku:

TEXMFMAIN = $SELFAUTOPARENT

na

TEXMFMAIN = $SELFAUTODIR

Jeśli przeniesiemy całość instalacji do innego katalogu, należy dokładnie to określić, modyfikując zmienną
TEXMFMAIN w pliku texmf.cnf, a także ustawiając TEXMFCNF na $TEXMFMAIN/texmf/web2c.

3.3. Instalacja pojedynczych pakietów z TEX Live na twardym dysku
TEX Live można używać zarówno do aktualizacji istniejącej instalacji, jak i do dodawania składników
do instalacji wcześniejszej. Główny program instalacyjny przeznaczony jest do użycia tylko za
pierwszym razem, natomiast później należy używać znajdującego się na CD-ROM-ie (DVD) skryptu
install-pkg.sh. Uruchamia się go przez zamontowanie nośnika, przejście do katalogu punktu
montowania i napisanie

> sh install-pkg.sh opcje

Skrypt posiada dziewięć parametrów; pierwsze cztery pozwalają wybrać: pojedynczy pakiet do
instalacji, cały zestaw (np. tex-mathextra), nazwę katalogu zamontowanego CD-ROM-u, oraz nazwę
katalogu zawierającego pliki ze spisami zawartości pakietów (zwykle te dwa ostatnie ustawiane są
automatycznie):

--package=pkgname pojedynczy pakiet do zainstalowania;

--collection=colname pojedynczy zestaw do zainstalowania;

--cddir=dir katalog źródłowy (domyślnie jest to katalog bieżący, z którego uruchomiono skrypt);

--listdir=dir katalog ze spisami plików (domyślnie ./texmf/tpm/lists).

Proces instalacji jest określony dokładniej przez pięć kolejnych parametrów; pierwsze dwa pozwalają
wyłączyć z instalacji dokumentacje lub pliki źródłowe, trzeci wyłącza domyślne uruchamianie na koniec
skryptu mktexlsr, który przebudowuje bazę danych o plikach, czwarty uruchamia na koniec skrypt
konfiguracyjny texconfig init zaś piąty powoduje jedynie wypisanie plików, które miałyby być
zainstalowane:
--nodoc
--nosrc
--nohash
--config
--listonly
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Można także określić, czy zamiast instalować pliki, skrypt powinien utworzyć archiwum tar
w wybranej lokalizacji:
--archive=nazwa

Dodatkowa opcja --verbose pozwala wyświetlić podczas uruchomienia bardziej szczegółowe
komunikaty.

Tak więc, jeżeli chcielibyśmy tylko zobaczyć przed zainstalowaniem, jakie pliki tworzą pakiet
fancyhdr, nasze polecenie wyglądałoby następująco:

> sh install-pkg.sh --package=fancyhdr --listonly

texmf/source/latex/fancyhdr/README
texmf/doc/latex/fancyhdr/fancyhdr.dvi
texmf/doc/latex/fancyhdr/fancyhdr.tex
texmf/tex/latex/fancyhdr/fancyhdr.sty
...

Oto inne przykłady użycia:

• zainstaluj LATEX-owy pakiet natbib:

> sh install-pkg.sh --package=natbib

• zainstaluj LATEX-owy pakiet alg bez plików źródłowych i bez dokumentacji:

> sh install-pkg.sh --package=alg --nosrc --nodoc

• zainstaluj wszystkie pakiety dostępne w zestawie dodatkowych makr dla Plain TEX:

> sh install-pkg.sh --collection=tex-plainextra

• spakuj wszystkie pliki wymagane dla PSTricks w pliku tar, w katalogu /tmp:

> sh install-pkg.sh --package=pstricks --archive=/tmp/pstricks.tar

3.4. Program texconfig
Gdy tylko program instalacyjny skopiuje wszystkie pliki w miejsce, gdzie mają być zainstalowane, można
użyć programu texconfig, pozwalającego konfigurować system według własnych potrzeb. Program ten
może być w każdej chwili uruchomiony do zmiany instalacji, z interfejsem pełnoekranowym (wymaga
on programu dialog, zawartego w pakietach z binariami) lub z linii poleceń. Program texconfig powinien
być używany do wszelkich zmian, takich jak deklaracja używanych drukarek czy przebudowywanie bazy
danych o plikach. Obydwa tryby pracy mają tekst pomocy opisujący możliwości.

Przykłady użycia z wiersza poleceń:

texconfig dvips paper letter ustawienie formatu papieru na „letter” dla programu dvips;

texconfig xdvi letter jak wyżej, ale dla programu xdvi;

texconfig rehash aktualizacja wszystkich baz danych instalacji systemu TEX;

texconfig faq wyświetla FAQ dystrybucji teTEX (na dystrybucji tej oparto TEX Live;

texconfig help wyświetla dostępne opcje skryptu.

Skrypt texconfig pozwala na zmianę jedynie najważniejszych ustawień. Głównym plikiem konfigura-
cyjnym jest texmf.cnf. Zlokalizujemy go uruchamiając polecenie „kpsewhich texmf.cnf”. Plik ten
zawiera sporo użytecznych komentarzy wyjaśniających reguły ustawień domyślnych oraz podaje przykłady
ustawień alternatywnych.
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3.5. Testowanie instalacji
Po zainstalowaniu TEX Live warto sprawdzić czy programy działają prawidłowo. Opiszemy tu podstawowe
procedury testowe funkcjonowania systemu w systemach Unix. W Mac OS X i Windows najczęściej
użyjemy środowiska graficznego (GUI), ale reguły są podobne.

1. Sprawdzamy najpierw czy uruchamia się program tex:

> tex --version
TeX (Web2C 7.5.2) 3.141592
kpathsea version 3.5.2
Copyright (C) 1997-2003 D.E. Knuth.
...

Jeśli uruchomienie zakończy się komunikatem command not found, oznacza to, że nieprawidłowo
zadeklarowano zmienną PATH.

2. Przetwarzamy prosty plik LATEX-owy:

> latex sample2e.tex
This is e-TeXk, Version 3.141592-2.1 (Web2C 7.5.2)
...
Output written on sample2e.dvi (3 pages, 7256 bytes).
Transcript written on sample2e.log.

Gdy program nie znajduje sample2e.tex (bądź innych wymaganych plików) może to oznaczać, że
nadal działają ustawienia zmiennych środowiska bądź pliki konfiguracyjne z poprzedniej instalacji.
Dogłębną analizę gdzie są przeszukiwane i znajdywane pliki umożliwia diagnostyka opisana
w części 7.2.4 na str. 43.

3. Podgląd wyniku składu:

> xdvi sample2e.dvi

Polecenie to wymaga uruchomionego środowiska graficznego X Window.

4. Przetwarzanie wyniku składu do PostScript w celu wyświetlenia lub wydruku:

> dvips sample2e.dvi -o sample2e.ps

5. Tworzenie dokumentu bezpośrednio w formacie PDF:

> pdflatex sample2e.tex

6. Podgląd dokumentu PDF:

> gv sample2e.pdf
lub:
> xpdf sample2e.pdf

Programy gv bądź xpdf są dostarczane zwykle w dystrybucjach systemu operacyjnego, wobec
tego nie zawarto ich na TEX Live. Przed samodzielną instalacją warto odwiedzić strony,
odpowiednio, http://wwwthep.physik.uni-mainz.de/~plass/gv i http://www.foolabs.
com/xpdf. W sieci dostępny jest także bezpłatny program Adobe Acrobat Reader (http://www.
adobe.com).

http://wwwthep.physik.uni-mainz.de/~plass/gv
http://www.foolabs.com/xpdf
http://www.foolabs.com/xpdf
http://www.adobe.com
http://www.adobe.com
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7. Inne przydatne pliki testowe:

docstrip.tex pomaga utworzyć plik źródłowy makr oraz dokumentację z plików „.dtx”;
small2e.tex bardziej prosty przykład niż sample2e;
testpage.tex test położenia wydruku na kartce papieru, przydatny do sprawdzenia, czy nasza

drukarka nie wprowadza przesunięć;
nfssfont.tex służy do wydruku tablic fontowych;
testfont.tex jak wyżej, ale zamiast LATEX-a wymaga jedynie plain TEX;
story.tex najbardziej kanoniczny przykład dla plain TEX; na zakończenie przetwarzania

uruchomionego poleceniem tex story, po ukazaniu się *, należy wpisać \bye.

Początkującym polecamy stronę http://tug.org/begin.html oraz podręcznik Petera Flyn-
na Formatting Information, dostępny na http://www.ctan.org/tex-archive/documentation/
beginlatex.

4. Instalacja dla systemu Mac OS X

Na komputerach Macintosh TEX Live obsługuje jedynie system operacyjny Mac OS X (starsze systemy
z działającym systemem TEX mogą korzystać z makr, fontów i dokumentacji o ile zainstalujemy
rozszerzenie Joliet dostępne na http://www.tempel.org/joliet). Instalacja w Mac OS X może być
wykonana na dwa sposoby:

1. za pomocą programu i-Installer załączonego w pliku MacOSX/II2.dmg;

2. za pomocą skryptu install-tl.sh, podobnie jak dla innych wersji Unix.

Każdą z nich opisano poniżej.

4.1. i-Installer: instalacja z sieci Internet
Program i-Installer załączono w dystrybucji TEX Live jako alternatywę dla standardowego programu
instalacyjnego. W zasadzie nie korzysta on z zawartości dystrybucji, zamiast tego system TEX jest
pobierany z sieci (ok. 70 MB). Zaletą jest tu łatwość aktualizacji oprogramowania. Opis działania dostępny
jest na stronie domowej: http://www.rna.nl/tex.html.

Aby użyć i-Installer należy zamontować ./MacOSX/II2.dmg, uruchomić program i zainstalować
przynajmniej TeX Foundation oraz TeX Programs. Instalacja pierwszego kończy się bez konfiguracji; gdy
tylko zainstalujemy „programy TEX-owe”, ukaże się środowisko graficzne (GUI), w którym wykonamy
niezbędne kroki konfiguracyjne.

Program i-Installer działa dla położenia drzewa katalogów zgodnego z teTEX. Jeśli wykonamy
standardową instalację (patrz poniżej) w innym katalogu, nie będzie można użyć programu do aktualizacji
oprogramowania.

4.2. Instalacja za pomocą install-tl.sh
Skrypt install-tl.sh jest skryptem powłoki sh (rozpoczyna się instrukcją #!/bin/sh), ale powłoka
tcsh pierwszych wersji systemu MacOSX nie potrafiła go wykonać. Najlepiej do tego wykorzystać
powłokę bash, która w systemie MacOSX nie była wcześniej instalowana domyślnie. Od wersji 10.2
uległo to zmianie, a więc instalujemy podobnie jak opisano to powyżej w części 3 na str. 9. Nie ma w tym
nic niezwykłego, ponieważ MacOSX jest systemem Unix. Warto zapoznać się jednak z następującymi
wskazówkami:

http://tug.org/begin.html
http://www.ctan.org/tex-archive/documentation/beginlatex
http://www.ctan.org/tex-archive/documentation/beginlatex
http://www.tempel.org/joliet
http://www.rna.nl/tex.html
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• zauważmy, że we wszystkich poleceniach z powyższych podrozdziałów sudo bash powinno
zastąpić sh. Na przykład polecenie

> sh install-tl.sh

powinno mieć postać

> sudo bash install-tl.sh

• w systemie MacOSX CD-ROM-y są montowane automatycznie, więc nie trzeba stosować polecenia
mount. CD-ROM zostanie zamontowany w katalogu /Volumes/. Jeśli chcemy, aby stał się on
katalogiem bieżącym, w oknie terminala należy wpisać:

> cd /Volumes/TeXLive...

w miejsce kropek wstawiamy rzeczywistą nazwę CD-ROM-u, wykorzystując tu funkcję automa-
tycznego uzupełniania (klawisz Tab).

4.3. Instalacja bash dla starszych wersji Mac OS X

Mac OS X w wersji 10.1 lub wcześniejszej nie udostępniał powłoki bash, wobec tego niemożliwe jest
w tych systemach uruchomienie skryptu install-tl.sh. Opiszemy tu jak zainstalować bash.

Najpierw sprawdzimy, czy powłoka bash jest już zainstalowana. W tym celu trzeba uruchomić
Terminal (/Applications/utilities/Terminal) i w oknie terminala wpisać:

> rehash; which bash

odpowiedź może być następująca:

• lokalizacja powłoki bash (na przykład /bin/bash albo usr/local/bin/bash), jeśli jest ona
zainstalowana;

• bash: command not found, jeżeli nie została jeszcze zainstalowana.

Jeżeli powłoka bash jest już zainstalowana, postępujemy jak to opisano powyżej. W przeciwnym
wypadku instalujemy powłokę bash:

Przyjazna procedura macintoshowa Na płytce w katalogu MacOSX należy odszukać obraz dysku
o nazwie bash.dmg. Po dwukrotnym kliknięciu na nazwie tego pliku obraz dysku (wolumen)
zostanie zamontowany. W tym wolumenie uruchamiamy aplikację i-Installer. Użytkownik
zostanie poproszony o przedstawienie się. Jeśli pierwszy raz widzimy taki komunikat, może
się okazać, że nie mamy wystarczających uprawnień do przeprowadzenia instalacji. Należy teraz
wpisać nazwę użytkownika i hasło, po czym kliknąć przycisk Install. Powłoka bash zostanie
zainstalowana w systemie.

Procedura z wykorzystaniem linii poleceń 1. Zalogować się jako użytkownik-administrator, a przy-
najmniej jako użytkownik o uprawnieniach administratora, użytkownik sudo albo Administra-
tor Systemu.

2. Przejść do katalogu MacOSX znajdującego się na płytce i skopiować plik bash.tar.gz do
katalogu domowego (~/).

3. Uruchomić Terminal, a następnie wpisać w oknie terminala następujące polecenie:

> (cd /usr/local/; sudo tar xvzf ~/bash.tar.gz)

Nacisnąć klawisz Enter. Użytkownik zostanie poproszony o hasło, a następnie bash zostanie
zainstalowany.

4. Zamknąć Terminal.

Po przeprowadzeniu którejkolwiek z powyższych procedur należy sprawdzić, czy bash został
zainstalowany (opisano to powyżej). Być może konieczne będzie wylogowanie i ponownie zalogowanie.



5 INSTALACJA I UŻYTKOWANIE POD WINDOWS 17

4.4. Środowiska pracy w Mac OS X

Na komputerach Macintosh używamy zwykle TEX-a w środowisku pracy obejmującym wiersz poleceń,
edytor, program do podglądu itp. Mamy do wyboru kilka takich środowisk:

TeXShop dostępny na TEX Live w pliku ./MacOSX/texshop.dmg. Szczegółowe informacje można
znaleźć na stronie http://www.uoregon.edu/~koch/texshop/texshop.html.

ITeXMac dostępny na TEX Live w pliku ./MacOSX/iTeXMac-*.dmg. Patrz też http://itexmac.
sourceforge.net.

Mac-emacs implementacja Emacs dla Mac OS X zintegrowana z AucTeX. Patrz też http://www.cs.
man.ac.uk/~franconi/mac-emacs.

Powyższe środowiska stosują /usr/local/teTeX jako domyślną lokalizację oprogramowania
TEX-owego, wobec tego instalację należy wykonać w tym katalogu (bądź zmienić konfigurację
środowiska).

4.5. Strona kodowa Macintosh CE
Piszący po polsku użytkownicy MacOSX mają do wyboru stosowanie dwóch 8-bitowych stron kodowych:

iso8859-2 – co się wiąże z wykorzystywaniem standardowego oprogramowania uniksowego (Cocoa
używa wyłącznie unikodu), jak na przykład Emacsa.

Mac CE – co pozwala na stosowanie tradycyjnego (Carbon) oprogramowania jak np.: BBEdit. Weźmy
pod uwagę ten przypadek.

Na TEX Live (tymczasowo w pakiecie platex, docelowo będzie dostępny w standardowych pakietach
LATEX-a) znajduje się plik macce.def, który pozwala LATEX-owi wczytywać polski tekst z wykorzystaniem
pakietu inputenc:
\usepackage[macce]{inputenc}
Ponadto mamy tablice przekodowań dla Mac CE, niewymagające stosowania pakietu \inputenc.

Zamiast niego wystarczy wpisać deklarację w pierwszym wierszu pliku:
%& --translate-file=macce-pl

5. Instalacja i użytkowanie pod Windows
Rozdział ten odnosi się do systemów Windows 9x, ME, 2000, NT lub XP.

Przed instalacją należy sprawdzić, czy Windows potrafi, przy czytaniu CD-ROM-ów, korzystać
z rozszerzeń Microsoft Joliet. Uruchamiając Eksplorator wystarczy sprawdzić, czy wyświetlana lista
plików CD-ROM-u posiada „długie” nazwy, pisane małymi i wielkimi literami. Jeżeli tak nie jest, nie
można używać systemu uruchamialnego bezpośrednio z CD-ROM-u.

Zawarte na TEX Live oprogramowaniie dla Windows to ni mniej, ni więcej dystrybucja fpTEX. Zawiera
m.in. przeglądarkę plików dvi, Windvi, która w użyciu podobna jest do Unixowego xdvi. Dokumentacja
znajduje się w texmf/doc/html/windvi/windvi.html.

5.1. Program TeXLive.exe
Jeśli system Windows jest skonfigurowany tak, aby umożliwiał automatyczny start programów po
włożeniu CD-ROM-u „inst” bądź DVD „live” do napędu, program TeXLive pokaże okno dialogowe,
w którym mamy do wyboru szereg opcji:

• Explore CD-ROM->Browse CD-ROM – przeglądanie zawartości płytki;

http://www.uoregon.edu/~koch/texshop/texshop.html
http://itexmac.sourceforge.net
http://itexmac.sourceforge.net
http://www.cs.man.ac.uk/~franconi/mac-emacs
http://www.cs.man.ac.uk/~franconi/mac-emacs
file:../../../../texmf/doc/html/windvi/windvi.html
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Rysunek 1: Okno programu TeXLive

• Explore CD-ROM->Run TeX off CD-Rom – uruchamianie systemu TEX bezpośrednio z płytki;

• TeXLive Software->Install on Hard Disk – instalacja na dysku twardym;

• TeXLive Software->Uninstall TeXLive – usunięcie systemu TEX;

• TeXLive Software->Maintenance – wykonanie niektórych czynności konfiguracyjnych;

• Documentation – przeglądanie wybranej dokumentacji: TEX Live (także w języku polskim), strony
TUG, strony dystrybucji fpTEX, a także uruchamianie TeXdocTK – programu do przeglądania
dokumentacji dotyczących systemu TEX.

Gdy włożenie CD-ROM-u (DVD) do napędu nie uruchamia automatycznie programu, należy
w oknie Eksploratora Windows wskazać bin/win32/TeXLive.exe i uruchomić program dwukrotnym
naciśnięciem klawisza myszy.
Uwaga: program TeXLive.exe uruchamia się z CD „demo” oraz DVD „live”. Włożenie do napędu
CD-ROM „inst” uruchomi (opisany niżej) program instalacyjny TeXSetup.exe.

5.2. Uruchamianie z CD-ROM-u
Wszystkie programy TEX-owe można uruchamiać bezpośrednio z CD-ROM-u, mając natychmiastowy
dostęp do wszelkich makr i fontów. Ceną jest tu wolniejsza praca niż w wypadku instalacji na
twardym dysku. Do efektywnej pracy wymagana jest modyfikacja zmiennych środowiska systemu
i utworzenie niewielkich, pomocniczych katalogów na dysku twardym. Katalogi te będą zawierały
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niezbędne pliki konfiguracyjne, pozwalające użytkownikowi na modyfikację ustawień programów
i samodzielne generowanie potrzebnych plików formatów. Ponadto, w pomocniczym katalogu będą
zapisywane generowane automatycznie fonty.

Wymienione kroki przygotowawcze wykonuje program TeXlive.exe. Po uruchomieniu programu
należy wybrać opcję Explore CD-Rom, następnie Run TeX off CD-ROM, co uruchomi edytor XEmacs.
Edytor jest uruchamiany w ramach zmienionego środowiska. W katalogu przeznaczonym na pliki
tymczasowe tworzone jest drzewo katalogów texmf, zgodne z TDS. Jest to potrzebne do automatycznego
generowania plików fontowych, a także przechowywania plików konfiguracyjnych (można je modyfikować
w razie potrzeby). Gdy w XEmacs otworzymy plik .tex, uruchomiony zostanie tryb AUC-TEX
z wygodnymi menu dla uruchamiania programów, ułatwienia wpisywania poleceń TEX-owych itp.
Z edytora mamy możliwość uruchomienia powłoki (M-x shell), a tym samym dostęp z wiersza poleceń
do wszystkich narzędzi zawartych na TEX Live.
Bardziej zaawansowani użytkownicy (szczególnie ci, którzy chcą uruchamiać programy z wiersza poleceń
i samodzielnie modyfikować ustawienia programów) mogą przygotować system, wykorzystując plik wsadowy
mkloctex.bat (katalog bin/win32/). Po skopiowaniu pliku na dysk twardy należy go uruchomić z wiersza poleceń
(okno DOS/CMD), podając dwa parametry: literę CD-ROM-u i literę dysku twardego, na którym chcemy utworzyć
pomocnicze drzewko TEX-owe. Po zapoznaniu się z końcowymi komunikatami wyświetlanymi przez program,
zalecane jest wykonanie sugerowanych tam czynności.

5.3. Programy pomocnicze dla Windows
Aby instalacja była kompletna, TEX Live wymaga kilku pomocniczych programów, które nie są
dostarczane wraz z systemem Windows. Wiele skryptów napisano w języku Perl, ponadto wiele narzędzi
wymaga programu Ghostscript (interpretera języka PostScript) do rasteryzacji bądź konwersji plików.
Przydatne są także w wielu wypadkach różne programy do obróbki grafiki. Wreszcie – posiadanie edytora
zorientowanego na środowisko TEX znacznie ułatwi pracę.

Wszystkie takie programy dla Windows dosyć łatwo znaleźć w sieci, ale ponieważ jest ich spory
wybór, postanowiliśmy te najbardziej godne polecenia umieścić w dystrybucji TEX Live:

• Ghostscript 7.07;

• minimalną dystrybucję Perl 5.8, wystarczającą do uruchomienia wszystkich, zawartych na TEX Live
skryptów perlowych;

• ImageMagick 5.5.6

• ISpell – korektor pisowni

• zaawansowany edytor XEmacs 21.5.14 wraz z kolekcją pakietów do wspomagania pracy w środo-
wisku programów TEX-owych.

Powyżej wymienione programy, tworzące pakiet nazwany XEmTEX, najlepiej zainstalować jednocze-
śnie.

Jeśli nie zamierzamy instalować XEmTEX, a nie wykryto w systemie obecności programów
Perl i Ghostscript, będą one i tak zainstalowane, ponieważ są wymagane do uruchomiania wielu
ważnych narzędzi. Ustawione ponadto zostaną zmienne środowiska PERL5LIB oraz GS_LIB. Zmienne te
wykorzysywane są przez Perl i Ghostscript (odpowiednio) przy poszukiwaniu plików bibliotek, skryptów
etc.

XEmTEX instalowany jest w tym samym katalogu, w którym instalujemy TEX Live. TeXSetup.exe –
program instalacyjny TEX Live dla systemów Windows – nie uruchamia żadnych zewnętrznych procedur
instalacyjnych programów pomocniczych. Pakiet XEmTEX jest samodzielnym zestawem, który wciąż się
rozwija (patrz strona projektu: http://www.fptex.org/xemtex/).

Jeśli nie zamierzamy zainstalować pakietu XEmTEX, należy samodzielnie uzupełnić instalację TEX
Live o potrzebne programy. Poniżej zamieszczono listę miejsc skąd możemy je pobrać:

http://www.fptex.org/xemtex/
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Ghostscript http://www.cs.wisc.edu/~ghost/

Perl http://www.activestate.com/ (uzupełniające, przydatne pakiety należy pobrać z zasobów
CPAN http://cpan.org)

ImageMagick bogaty zestaw narzędzi do wsadowego przetwarzania plików graficznych (http://www.
imagemagick.com)

NetPBM zamiast ImageMagick do przetwarzania i konwersji plików graficznych możemy użyć NetPBM
(http://netpbm.sourceforge.net/)

Edytory dla systemu TEX mamy tutaj spory wybór, zależny od indywidualnych preferencji użytkowni-
ka:

• GNU Emacs w wersji klasycznej dla Windows (http://www.gnu.org/software/emacs/
windows/ntemacs.html)

• XEmacs – bardziej przyjazna wersja dla Windows (http://www.xemacs.org/)

• WinShell – prosty edytor/shell, dostępny na TEX Live w katalogu support/WinShell
(http://www.winshell.de)

• WinEdt – bogaty edytor dla TEX-a, dostępny jako shareware (http://www.winedt.com)

• TeXnicCenter – kolejny, dosyć bogaty edytor (http://www.toolscenter.org/products/
texniccenter/)

• Vim – rozbudowany i bardzo silny edytor, wywodzący się z klasycznego dla systemów Unix
vi, dostępny na TEX Live w katalogu support/vim (http://www.vim.org)

• SciTE – edytor dostępny w sieci http://www.scintilla.org/SciTE.html

Możemy zainstalować z sieci także inne narzędzia, których zabrakło na TEX Live z powodów
licencyjnych. Przykładem jest tu GSView, wygodny program wykorzystujący Ghostscript do wyświetlania
i drukowania plików PS/PDF. Dostępny jest on m.in. na http://www.cs.wisc.edu/~ghost/gsview/,
a także na każdym serwerze CTAN.

5.4. Instalacja na twardym dysku
Instalację rozpoczyna się od uruchomienia (automatycznie – po włożeniu płytki „inst” do napędu, lub
bezpośrednio – z katalogu bin\win 32) programu TeXSetup.exe (w wypadku CD-ROM-u „demo”
i DVD „live” uruchamia się najpierw program TeXLive.exe; z menu TeXLive Software należy wybrać
podmenuInstall on Hard Disk). Program TeXSetup.exe posiada szereg ekranów dialogowych:

Ekran ‘Welcome. . . ’ (rys. 2, po lewej); można tu wybrać Quick Install – szybką instalację, bez in-
terwencji użytkownika, z domyślnym wyborem zestawów (tex-basic, tex-latex i tex-pdftex.
Jeśli jednak chcemy zainstalować dodatkowe programy pomocnicze (edytor, Ghostscript), nie
należy używać tej opcji. Zaznaczenie okienka wyboru Install XEmTeX Support spowoduje
zainstalowanie całego zestawu: edytor XEmacs, Perl, Ghostscript, ImageMagick i Inspell. W wer-
sjach Windows gdzie ma to zastosowanie, można uaktywnić opcję Install for all users,
co umożliwi korzystanie z instalacji przez wszystkich użytkowników (wymagane są do tego
uprawnienia administratora systemu!);

Ekran ‘Source. . . ’ zawiera nieco więcej elementów; pozwala wybrać źródło instalacji (dla CD TEX Live
ustawiany jest domyślnie napęd CD-ROM, może to też być lokalny katalog na dysku twardym),
ponadto pozwala zainstalować dodatkowe programy bezpośrednio z Internetu (rys. 2, po prawej).

Do czego potrzebne mogą być różne źródła instalacji? Właściwe pliki systemu TEX Live są zawarte
na płytce, ale brak niektórych pakietów, przydatnych dla użytkowników Windows, czy to z powodu

http://www.cs.wisc.edu/~ghost/
http://www.activestate.com/
http://cpan.org
http://www.imagemagick.com
http://www.imagemagick.com
http://netpbm.sourceforge.net/
http://www.gnu.org/software/emacs/windows/ntemacs.html
http://www.gnu.org/software/emacs/windows/ntemacs.html
http://www.xemacs.org/
http://www.winshell.de
http://www.winedt.com
http://www.toolscenter.org/products/texniccenter/
http://www.toolscenter.org/products/texniccenter/
http://www.vim.org
http://www.scintilla.org/SciTE.html
http://www.cs.wisc.edu/~ghost/gsview/
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TeXSetup Wizard Katalogi źródłowe instalacji TEX Live

Rysunek 2: Program TeXSetup wizard

braku miejsca, czy też z powodu ograniczeń licencyjnych. Aby zainstalować dodatkowe programy
z Sieci należy włączyć opcję Enable Internet Download.

Nie należy traktować powyższego jako ograniczenie; CD-ROM pozwala zainstalować w pełni
funkcjonalny system TEX. Programy dodatkowe (np. WinEdt) można doinstalować później,
w dowolnej chwili.

Pliki mogą więc być zainstalowane:

• z CD-ROM-u lub podobnego drzewa katalogów, dostępnego w którymś z katalogów (oznacza
to, że CD-ROM może być zamontowany na zdalnym komputerze i udostępniony w sieci);

• ze skompresowanych plików .zip, pobranych z Sieci i dostępnych na dysku (jest to przypadek
CD-ROM „inst” i dystrybucji fpTEX);

• z Internetu, w tym przypadku program pobierze z sieci pliki .zip, rozpakuje je i zainstaluje.

Ostatnia opcja jest dostępna tylko wtedy, gdy włączymy możliwość pobierania plików z Inter-
netu (prawa strona ekranu dialogowego). Możemy tu skonfigurować sposób pobierania plików:
wykorzystując bibliotekę wininet.dll Internet Explorera 5x lub bezpośredni dostęp (ftp, http).
Wreszcie możemy określić lokalny (local source directory) i sieciowy katalog źródłowy plików
instalacji (remote source directory). Przycisk browse (przeglądaj) pozwala na łatwy wybór zarówno
pierwszego, jak i drugiego (adres sieciowy URL, z listy dostępnych repozytoriów) źródła instalacji.

Root of Installation kolejny ekran pozwala na wybór katalogów (rys. 3, po lewej), w których program
ma umieścić główną dystrybucję i lokalną konfigurację (z powodu „dziwnych” właściwości
Windows 2000 domyślnie proponowany jest dysk C: i katalog \Program Files\TeXLive,
w innych wersjach Windows możemy wybrać po prostu katalog \TeX dowolnego dysku – uwaga
tłumacza). Jedynie wybór głównego katalogu (Root directory) jest naprawdę istotny; inne katalogi
są ustawiane względem katalogu głównego. W okienku Extra TeXMF tree można wskazać
dowolny katalog, zgodny ze strukturą TDS, zawierający dodatkowe zasoby TEX-owe. Z kolei katalog
określany przez zmienną $HOMETEXMF ustawiany jest domyślnie w zależności od tego, jak nasza
instalacja Windows „interpretuje” zmienną HOME (w instalacjach jednostanowiskowych jest to po
prostu katalog Moje dokumenty, w którym można utworzyć zgodne ze strukturą TDS lokalne
drzewo texmf). Oczywiście można zrezygnować z tworzenia dodatkowych katalogów Local,
Extra i Home, usuwając wpisane w okienkach wartości.
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Główny i dodatkowe drzewa katalogów instalacji Wybór predefiniowanych zestawów

Rysunek 3: TEX Live-Setup: Katalogi instalacji / Predefiniowane zestawy

Ekran ‘Get TPM’ nie wymaga interwencji użytkownika. Pliki .tpm, które opisują zawartość zestawów
i pakietów, są pobierane (niekiedy z Internetu), rozpakowywane (jeśli wymaga tego potrzeba)
i analizowane.

‘Scheme selection’ menu pozwala wybrać do zainstalowania predefiniowane zestawy pakietów (rys. 3,
po prawej): podstawowy, rekomendowany, pełny, albo zalecane zestawy dla grup użytkowników (np.
GUTenberg dla frankofonów lub GUST dla Polaków). Nawet jeśli wybrano zestaw (Scheme) nadal
możliwa jest jego szczegółowa specyfikacja (dodanie bądź usunięcie poszczególnych pakietów)
po zaznaczeniu okienka obok napisu I want to customize the selected scheme. W takim wypadku
wyświetlony zostanie ekran wyboru pakietów. Gdy nie włączymy opcji, program przeskoczy od
razu do ekranu przeglądowego, wyświetlającego listę pakietów do instalacji.

‘Packages Selection’ menu pozwala wybrać pakiety lub zestawy pakietów do zainstalowania (opis
zestawów i pakietów znajduje się w rozdziale 2.5). Wyboru dokonuje się przez rozwijanie
poszczególnych gałęzi zestawów – podobnie jak to ma miejsce w Eksploratorze Windows
– i zaznaczaniu/odznaczaniu potrzebnych elementów (rys. 4, po lewej). Można zrezygnować
z instalacji pojedynczego zestawu lub pakietu, ale akcja ta powiedzie się jedynie wtedy, gdy
wybrany element nie będzie zależny od innych. Przykładowo, nie można odznaczyć zestawu
tex-basic bez uprzedniej eliminacji wszystkich zestawów zależnych. Trzy zestawy (tex-basic,
tex-latex i tex-pdftex) są zaznaczone domyślnie jako najczęściej wymagane (zalecane). Zaznaczone
jest także instalowanie dokumentacji pakietów. Można ponadto wybrać instalowanie plików
źródłowych pakietów makr (Source Files), choć nie są one potrzebne do bezpośredniej pracy.
Uwaga: Wybór zestawu zawierającego polskie pakiety wymaga zaznaczenia tex-langpolish
(jest on domyślnie zaznaczony gdy uprzednio wybrano schemat instalacji dla GUST).

Dodatkowo, w zestawie tex-xemtex, można wybrać do zainstalowania skonfigurowany dla TEX-a
edytor XEmacs, Ghostscript, Perl, ImageMagick i Ispell. (rys. 4, po prawej). Żaden z tych
programów nie jest instalowany domyślnie!

Ekran udostępnia ponadto informacje o objętości pakietów oraz wymaganej i dostępnej pojemności
dysku.

‘Review Page’ (przegląd wyboru dokonanego przez użytkownika) – ekran ten prezentuje podsumowanie
dokonanych wyborów (rys. 5, po lewej). Nadal możliwe jest cofnięcie się do poprzednich menu
i zmiana decyzji.
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Wybór pakietów Programy dla Win32

Rysunek 4: Wybór pakietów i Dodatkowe programy dla Win32

Ekran ‘File Copy’ prezentuje postęp procesu instalacji – kopiowanie plików (w miarę potrzeby
pobieranych z Internetu i rozpakowywanych), rys. 5, po prawej.

‘Configuration’ wiele pakietów, a także cały system TEX, wymaga uprzedniej konfiguracji (rys 6, po
lewej). Wstępny etap podstawowej konfiguracji jest w pełni automatyczny. Na tym etapie genero-
wane są plików formatów, tworzone są bazy danych instalacji, ustawiane zmienne środowiskowe
itp. Czynności te są czasochłonne i niekiedy wymagają od użytkownika nieco cierpliwości.

Ekran przeglądu Kopiowanie plików

Rysunek 5: Przegląd pakietów i Kopiowanie plików

Ekran ‘Congratulations. . . ’ końcowy ekran (rys. 6, po prawej) pozwala obejrzeć plik .log instalacji.
Jeśli zachodzi taka potrzeba (Win9x/ME), proponowany jest restart systemu.

Należy być świadomym, że rozmiar klastra (cluster) partycji dysku DOS-owego może mieć radykalny
wpływ na rozmiar instalacji TEX-a. Drzewo z plikami TEX-owymi zawiera setki małych plików i często
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Ekran konfiguracji Ekran końcowy

Rysunek 6: Ekran konfiguracji i Ekran końcowy

zdarza się, że kompletna instalacja zajmuje do czterech razy więcej miejsca niż objętość samego
CD-ROM-u.

6. Zarządzanie systemem TEX Live w Windows

6.1. Różnice w stosunku do standardowego Web2C w systemach Win32
Web2C działający w systemach Win32 posiada szczególne cechy, o których warto wspomnieć.

Kpathsea – tablice haszowe, tworzone w TEX Live przez bibliotekę Kpathsea, są bardzo duże. Aby
skrócić czas uruchamiania dowolnego programu, wykorzystującego Kpathsea, tablice haszowe
zostają umieszczone w pamięci współdzielonej przez procesy. W ten sposób zmniejszono znacznie
czas uruchamiania programów wywoływanych kolejno, jeden przez drugi (np. tex wywołujący
mpost wywołujący tex). Zmianę tę ukryto przed użytkownikiem, z wyjątkiem sytuacji, gdy
zostanie użyty -1 dla diagnostyki działania Kpathsea; można wtedy śledzić wykorzystanie pamięci
współdzielonej.

kpsecheck – program ten oferuje kilka opcji opcji uzupełniających dla programu kpsewhich. Pozwala na
wylistowanie wszystkich plików, które występują wielokrotnie w dostępnych drzewach katalogów
texmf. Może to być przydatne, choć często możemy otrzymywać niepożądane komunikaty o dzie-
siątkach plików typu README1. Aby tego uniknąć, należy użyć opcji -multiple-occurences
wraz z dwiema innymi, pozwalającymi podać wzorce nazw do pominięcia lub włączenia w procesie
przeszukiwania (można podać kilka wzorców).

kpsecheck raportuje także stan pamięci współdzielonej: używanej i nieużywanej. Warto czasem
o tym wiedzieć, gdyż pokazywany status „pamięć w użyciu” może oznaczać, że działa kilka
procesów i efekt wykonania polecenia mktexlsr zostanie każdorazowo opóźniony do czasu, aż nie
będzie pracował żaden program korzystający z Kpathsea.

kpsecheck pozwala także określić położenie programu Ghostscript. W systemach Win32 łatwiej
jest wielu programom skorzystać z biblioteki DLL programu Ghostscript i znaleźć ją na podstawie

1Warto tu wspomnieć, że takie pliki powodują „zapychanie” się mechanizmu haszowego Kpathsea; na szczęście biblioteka ta
nigdy ich nie wyszukuje.
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rejestrów systemowych, niż na podstawie zmodyfikowanej przez użytkownika zmiennej PATH
(ponadto zmienne środowiskowe, szczególnie w starszych wersjach systemu Windows, mają dość
ograniczoną pojemność).

Web2C – programy dla Windows posiadają kilka dodatkowych opcji nieobecnych w wersjach kompilo-
wanych dla Unix i jedną działającą nieco inaczej:

• -halt-on-error pozwala zatrzymać przetwarzanie na pierwszym napotkanym błędzie;

• -job-time ustawia czas tworzonych plików na taki sam jak plik przetwarzany;

• -output-directory pozwala na zapisanie wyniku pracy w wyspecyfikownym katalogu (np.
możemy uruchomić program tex z plikiem znajdującym się na dysku tylko do odczytu zaś
zapisać wynik na dysku pozwalającym na zapis);

• -time-statistics wyświetla statystyki dotyczące czasu przetwarzania; warto tu wspo-
mnieć, że systemy Win9x, nie będąc prawdziwymi systemami wielozadaniowymi, nie mają
prawidłowo działającego pomiaru czasu dla krótkotrwałych procesów, wobec tego wyświetlane
wartości są jedynie przybliżone; w NT/2K/XP wyniki są bardziej dokładne; w Win32 brak
polecenia time znanego z systemów Unix.

6.2. Dodawanie pakietów do instalacji
Po głównej instalacji istnieje możliwość doinstalowania dowolnych pakietów. Z menu systemowego:
Start -> Programy -> TeX Live -> Maintenance należy wybrać -> Add TeX Package, co uruchomi
program TeXSetup z odpowiednimi parametrami (uruchomienie TeXSetup --help wyświetli dostępne
opcje programu). Po wczytaniu plików definiujących pakiety (.tpm) wyświetlony zostanie od razu ekran
wyboru zestawów/pakietów (podobnie jak podczas instalacji początkowej). W trybie doistalowania lista
pakietów już zainstalowanych jest porównywana z listą pakietów dostępnych z katalogu źródłowego.
Pakiety niezainstalowane wyświetlane są zielonym kolorem, zdezaktualizowane kolorem czerwonym, zaś
aktualne, zainstalowane – kolorem czarnym. Dzięki temu można nie tylko dodać nowe komponenty
z CD-ROM-u lub z Sieci, ale i zaktualizować posiadane pakiety o dostępne w Sieci nowsze wersje.

Gdy zamierzamy dodać pakiety, których brak w dystrybucji TEX Live (lub fpTEX), warto instalować
je w katalogu specyfikowanym przez zmienną $TEXMFLOCAL. W ten sposób zabezpieczymy te pakiety
podczas aktualizacji/wymiany oprogramowania TEX Live.

Katalog wskazywany przez $TEXMFLOCAL jest początkowo pusty. Przykładowo: dodajemy pakiet
dla Maple (przetwarzanie symboliczne); pliki stylów należy skopiować do katalogu ...\TeXlive\
texmf-local\tex\latex\maple\ zaś pliki dokumentacji do katalogu ...\TeXlive\texmf-local\
doc\latex\maple\

Na zakończenie należy koniecznie zaktualizować bazę danych instalacji ls-R: albo poprzez wybór
menu Start -> Programy -> TeXLive -> Maintenance, albo przez uruchomienie z linii poleceń
mktexlsr.

6.3. Usuwanie TEX Live z dysku twardego
Procedura deinstalacji oprogramowania dostępna jest z programu TeXLive.exe, z menu systemowego
TeXLive bądź z Panelu sterowania (Dodaj/usuń programy). Procedura ta usuwa z dysku większość plików
TEX Live. Ponieważ TEX jest systemem, który sam tworzy wiele plików, niełatwo śledzić wszystkie z nich.
Dodatkowe programy posiadają swoje własne procedury deinstalacyjne, wobec tego należy je uruchomić
odrębnie. Pliki umieszczone w katalogu wskazywanym przez zmienną $TEXMFLOCAL nie będą oczywiście
usuwane, a więc jeśli zachodzi taka potrzeba, należy je usunąć samodzielnie.
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6.4. Uruchamianie TeXSetup z linii poleceń
Program TeXSetup.exe posiada szereg interesujących opcji, które mogą być wyświetlone po urucho-
mieniu z linii poleceń (okno DOS):

c:\>TeXSetup --help

Oto opis dostępnych opcji programu:

--automatic-reboot po zakończeniu instalacji restart systemu, bez czekania na potwierdzenie
użytkownika;

--dry-run symulacja instalacji, nic nie jest instalowane, tworzony jest tylko plik .log rejestrujący
czynności, które program wykonuje podczas zwykłego uruchamiania bez tej opcji;

--quick wykonanie instalacji rekomendowanej, bez interwencji użytkownika;

--net-method (ie5/direct) umożliwienie pobierania z Internetu dodatkowych pakietów (wymagane
jest aktywne połączenie, albo bezpośrednim łączem, albo modemem, z wykorzystaniem bibliotek
DLL Internet Explorera wersji co najmniej 5; należy pamiętać, że niektóre pobierane pakiety mają
duże rozmiary);

--remote-source-directory <url> bazowy adres url dla pakietów pobieranych z sieci;

--local-source-directory <dir> domyślnie jest to katalog nadrzędny w stosunku do położenia
programu TeXSetup; gdy zaktualizujemy sam program, opcja ta pozwala nam na jego urucho-
mienie bezpośrednio z dysku twardego (np. texsetup --local-source-dir=e:\ gdzie e: jest
stacją CD);

--installation-directory <dir> główny katalog, w którym instalowany jest system TEX; domyślna
lokalizacja to c:\Program Files\TeXLive;

--texmfmain-directory <dir>

--texmflocal-directory <dir>

--texmfextra-directory <dir>

--texmfhome-directory <dir>

--vartexmf-directory <dir>

--vartexfonts-directory <dir> wszystkie te opcje pozwalają wyspecyfikować katalogi dla różnych
drzew texmf i zostaną zarejestrowane w zmiennych specyfikowanych w pliku texmf.cnf;

--with-source-files(=yes/no) instalacja plików źródłowych pakietów (domyślnie nie są one
instalowane);

--with-documentation-files(=yes/no) instalacja plików z dokumentacją poszczególnych pakie-
tów; uwaga: ogólna dokumentacja będzie zainstalowana nawet bez użycia tej opcji;

--program-folder <folder> nazwa folderu w menu startowym, w ramach którego znajdą się menu
instalacji;

--add-package <pkg> opcja używana do dodawania pakietów;

--scheme <pkg> instalacja wyspecyfikowanego zestawu, zamiast zestawu rekomendowanego domyśl-
nie;
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--maintenance działanie podobne jak --add-package, bez specyfikowania pakietów do doinstalowa-
nia w linii poleceń;

--uninstall opcja usuwania pakietów zainstalowanych z CD-ROM-u; jeśli dodano pliki z innego źródła,
utworzono formaty, zainstalowano pomocnicze programy itp., nie będą one usunięte;

--help pokazuje dostępne opcje programu.

6.5. Instalacja sieciowa
Biblioteka Kpathsea rozpoznaje nazwy UNC, wobec tego możemy ich użyć dla specyfikacji drzew
katalogów TEXMF udostępnianych w sieci komputerowej. Wszystkie pliki z wyjątkiem zawartych
w katalogu bin/win32 mogą być współdzielone z instalacjami teTEX lub TEX Live systemów Unix/Linux.
Oznacza to, że można użyć Samby do zamontowania serwera NT dla stacji roboczej Unix lub odwrotnie:
serwer np. Linux może udostępniać zasoby dla stacji Windows. Dostępne są możliwości:

• Instalacja całego oprogramowania na serwerze. Wystarczy dodać binaria dla wymaganych systemów
w podkatalogach bin, np. bin/win32 i bin/i386-linux, następnie należy ustawić główne
zmienne środowiska. W Windows można użyć nazw UNC dla wskazania odpowiednich katalogów.

• Instalacja lokalnych kopii binariów i plików formatów. W tym wypadku należy przypisać zmienną
$TEXMFMAIN do katalogu dostępnego na zdalnej maszynie (w sieci), a zmienną $VARTEXMF do
katalogu, który będzie przechowywał lokalne pliki konfiguracyjne i inne generowane pliki.

6.6. Konfiguracja indywidualna
6.6.1. Dvips

Plik konfiguracyjny config.ps programu Dvips znajduje się w katalogu ...\TeXlive\texmf-var\
dvips\config\. Plik ten można otworzyć w dowolnym edytorze (np. w WinShell) po to, aby zmienić
niektóre parametry działania Dvips. Najważniejsze z nich zgrupowano w blokach deklaracji:

fonty – można zmienić domyślne parametry generowania fontów przez METAFONT-a dla danej drukarki
(parametr M) i rozdzielczość (parametry D, X, Y). Standardowo fonty generowane są dla drukarek
laserowych, zgodnych z Hewlett Packard (tryb ljfour) i rozdzielczości 600 dpi. Domyślnie ustawiono
wykorzystanie fontów CM (oraz PL) w ich wersji obwiedniowej (Type 1), wobec tego Dvips nie
powinien odwoływać się zbyt często do programu mktexpk.

drukarka – parametr ‘o’ określa nazwę portu/przekierowania wydruku. Gdy nie wpisano nazwy drukarki
(portu), wynik pracy będzie zapisywany w pliku PostScriptowym .ps. Drukarkę specyfikujemy
jednym z poniższych sposobów:

o lpt1:
% o | lpr -S server -P myprinter
% o \\server\myprinter

Uwaga: Obecna dystrybucja TEX Live posiada zaimplementowaną po raz pierwszy procedurę
automatycznej aktualizacji map fontowych dla Dvips i Pdftex, wykonywaną przez program updmap
podczas instalacji, a także podczas dodawania pakietów z fontami. Jeśli fonty dodawane są „ręcznie”,
należy zmodyfikować plik updmap.cfg w katalogu $VARTEXMF/web2c i następnie uruchomić program
updmap.
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6.6.2. Pdftex

Konfiguracja programu pdf(la)tex wymaga modyfikacji pliku
...\TeXlive\texmf-var\pdftex\config\pdftex.cfg
W pliku tym możemy deklarować dodatkowe mapy fontowe wczytywane przez program, choć obecnie
tworzone są one automatycznie przez program updmap (patrz „Uwaga” zamieszczona powyżej). Ponadto
można ustawić inne parametry pracy programu pdftex (rozmiar papieru, stopień kompresji itp.). Parametr
output_format z wartością 1 oznacza, że pdftex będzie tworzył domyślnie pliki od razu w formacie
pdf (wartość 0 oznacza tworzenie plików .dvi, identycznie jak programem tex).

6.6.3. GSView

Począwszy od wersji zgodnej z Ghostscript 6.50, GSView jest niestety programem shareware, wobec
tego nie mógł znaleźć się na CD-ROM-ie.

Parametry pracy programu są ustawiane m.in. w menu Media. W podmenu Display Settings
można poprawić (kosztem szybkości pracy) sposób wyświetlania: parametry Text Alpha i Graphics
Alpha należy ustawić na 4 bity. W menu Media można też określić rozmiar papieru i jego orientację.

Uwagi dotyczące drukowania zawarto poniżej, w podrozdziale 6.8.

6.6.4. WinDvi

Podczas instalacji TeXSetup.exe ustawia skojarzenie plików .dvi z uruchamianiem programu Windvi.
W menu View ->Options można ustawić niektóre parametry pracy Windvi, np. możliwość

uruchamiania programów zewnętrznych (Allow shell), automatyczne odświeżanie zmienionego pliku
.dvi (Autoscan), tryb pracy METAFONT-a i rozdzielczość generowanych fontów (MF mode i Pixels
per inch), współpracę z Ghostscriptem (Postscript) itp. Po zakończeniu pracy programu parametry
zapisywane są w pliku $HOME/windvi.cnf (lub Moje dokumenty/windvi.cnf). Położenie tego pliku
można ustalić po uruchomieniu z wiersza poleceń:

c:\>kpsewhich --expand-var $HOME/windvi.cnf

W wypadku błędnego ustawienia parametrów pracy Windvi plik konfiguracyjny wystarczy skasować.

6.7. Testowanie
Ogólne wskazówki dotyczące weryfikacji instalacji zawarto w części 3.5 na str. 14. Tu omówimy jedynie
kwestie specyficzne dla Windows.

Dla szybkiej kontroli poprawności instalacji należy uruchomić edytor i otworzyć plik sample2e.tex
(znajduje się on w katalogu C:\Program Files\TeXlive\texmf\tex\latex\base\). Na belce
z narzędziami wybrać z menu Command→LaTeX (XEmacs), lub wcisnąć ikonę uruchamiania programu
latex (WinShell). Następnie wybrać z menu Command→View DVI (XEmacs), lub wcisnąć ikonę
podglądu DVI (WinShell). Pierwsze uruchomienie windvi zazwyczaj automatycznie generuje wymagane
fonty ekranowe. Po kilku sesjach komunikaty dotyczące generowania fontów staną się rzadsze.

Uwaga: jeśli program latex nie może znaleźć pliku do przetwarzania, naciśnięcie Ctrl-z spowoduje
natychmiastowe zakończenie pracy.

6.8. Drukowanie
Drukowanie bezpośrednio z programu Windvi odbywa się z wykorzystaniem uniwersalnego sterownika
druku systemu Windows. Z definicji powinien być on zgodny z większością drukarek, jednakże ma
on tendencję do tworzenia olbrzymich plików kolejek (spool) i niektóre (starsze) wersje Windows
po prostu tego nie akceptują. Zaletą sterownika jest jedynie możliwość obsługi grafik BMP i WFM.
Stosując metodę druku via sterownik Windows należy prawidłowo ustawić parametry rozdzielczości
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(patrz podrozdział 6.6.4), w przeciwnym wypadku otrzymany wydruk może być przeskalowany (np.
drukując w rozdzielczości 600dpi na drukarce 300dpi otrzymamy niespodziewanie 1/4 zamierzonego
rozmiaru wydruku).

Drukowanie znacznie szybsze i bardziej niezawodne zapewni konwersja pliku .dvi do .ps
programem Dvips i wykorzystanie GSView. Z menu Plik należy wybrać Drukuj, co wyświetli okno
dialogowe z szeregiem opcji. Gdy mamy drukarkę PostScriptową, należy wybrać PostScript printer.
Drukowanie na drukarkach bez interpretera PostScript wymaga zaznaczenia opcji Ghostscript device
(w sekcji „Print Method” okna) i wybrania przyciskiem po prawej stronie odpowiedniego urządzenia.

6.9. WinShell
Jeśli nie decydujemy się na rozbudowany (ale i bardzo silny) edytor XEmacs, możemy samodzielnie
zainstalować prosty i łatwy w obsłudze edytor WinShell. Znajdziemy go na płytkach w katalogu
support/WinShell. Wystarczy dwukrotnie kliknąć klawiszem myszy na znajdującym się tam pliku
.exe. Program uruchamiamy z menu Start bądź z ikony/skrótu na pulpicie. Dostosowanie do polskiej
wersji Windows wymaga, prócz określenia języka dla menu i komunikatów, użycia menu Opcje (Options)
-> Font -> Zmień i wyboru w wyświetlonym oknie Skrypt napisu Europa Środkowa. Dzięki temu
wpisywane za pomocą prawego klawisza Alt polskie znaki diakrytyczne będą prawidłowo wyświetlane.

Aby skonfigurować uruchamianie programów otwieramy menu Options -> Program Calls.

• W zakładce DVIWin, w polu „exe-file”, powinno być już wpisane windvi.exe.

• W zakładce Ghostview należy sprawdzić, czy prawidłowo podano ścieżkę dla gsview32.exe:
C:\ghostgum\gsview\gsview32.exe (dla wersji 3.6 i nowszych).

Wciskając przycisk OK zatwierdza się zmiany.
Instalacja programu ustawia w Windows skojarzenie plików .tex z uruchamianiemWinShell. Dopóki

nie zamierzamy korzystać z innego edytora (jak WinEdt lub Emacs) jest to poprawne.
WinShell posiada pomoc, dostępną po naciśnięciu symbolu ? na belce z narzędziami.

6.9.1. Instalacja poprawek

Ingo de Boer, autor WinShell, udostępnia od czasu do czasu kolejne wersje beta programu. Można je
pobrać z http://www.winshell.de. Zwykle są to pliki .zip, które należy rozpakować w katalogu,
w którym już zainstalowano WinShell (najczęściej w c:\Program Files\WinShell), zezwalając na
nadpisanie dotychczasowej zawartości. Program rozpakowujący unzip.exe można znaleźć na CD
w katalogu support/.

6.9.2. Użycie plików „projektu”

Wielokrotnie mamy do czynienia z dokumentami składającymi się z wielu części. Najwygodniej gdy
są one zapisane w odrębnych plikach. WinShell umożliwia utworzenie pliku projektu (Project file),
w którym deklarujemy poszczególne części większego dokumentu. Nazwy pliku projektu, traktowanego
jako główny edytowany plik (Main file), oraz plików części są wyświetlane w lewym oknie edytora.
Dwukrotne kliknięcie myszą na nazwie pliku pozwala na szybki wybór i wyświetlenie potrzebnego
pliku w głównym oknie edytora. Naciśnięcie ikony LaTeX na belce narzędziowej uruchamia zawsze
przetwarzanie głównego pliku, bez względu na to który plik jest aktualnie wyświetlany.

Na belce narzędziowej mamy dodatkowe przyciski pozwalające wyłączyć lub włączyć wyświetlanie
okna projektu (po lewej stronie) i okna zapisu sesji (log) – na dole. Gdy plik projektu nie jest używany,
lewą część okna można zamknąć, wykorzystując całą szerokość ekranu dla edytowanego pliku.

mailto:idb@winshell.de
http://www.winshell.de
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6.9.3. Drukowanie z WinShell na drukarce PostScriptowej

Ikona Dvips belki narzędziowej uruchamia program, który wynik pracy zapisuje zwykle w pliku .ps.
Oglądanie i/lub drukowanie takiego pliku wymaga uruchomienia GSView.WinShell pozwala zdefiniować
wygodne wywołanie polecenia dvips, które wynik przetwarzania wyśle od razu do drukarki posiadającej
interpreter PostScript. Przykładowo, dla drukarki o nazwie vclw, postępowanie będzie następujące:

1. Deklaracja danej drukarki w programie:

• otworzyć WinShell, wybrać menu Opcje -> Programy użytkownika.

• wybrać Tool 1 w spisie po prawej stronie i wypełnić pola po stronie lewej, np.:
Name: Drukuj
exe file: dvips
cmd-line: -D600 %c.dvi -o vclw
skasować zaznaczenie okienka „najpierw DVIPS”

• nacisnąć OK.

2. Dodanie polecenia „Drukuj” do belki narzędziowej:

• wybrać menu Opcje -> Przeglądaj -> Dostosuj paski;

• w okienku Kategoria wybrać Programy użytkownika;

• wskazać Drukuj i przeciągnąć go myszą na belkę narzędziową, umieszczając w dowolnym
miejscu obok innych poleceń;

• w kolejno wyświetlanym oknie dokonać wyboru: „Tylko obrazek” (Image only), „Tylko tekst”
lub „Tekst i obrazek”; najprościej wybrać „Tylko tekst” i zatwierdzić guzikiem OK. Napis
Drukuj ukaże się na belce (bardziej wymagający użytkownicy mogą wybrać opcję „Tylko
obrazek”, następnie „Edytuj” i skonstruować sobie własną ikonkę).

Uruchamianie polecenia zostało zdefiniowane. Aby drukować bezpośrednio na drukarce wystarczy teraz
nacisnąć guzik z napisem „Drukuj”.

6.10. Wskazówki dla użytkowników Win32
6.10.1. Różne wcielenia Win32

To, co nazywamy Win32 nie jest właściwie systemem operacyjnym a jedynie zbiorem funkcji, z których
wiele (ok. 12000) można użyć do pisania programów dla różnych systemów operacyjnych rodziny
Windows. Spotykamy różne wersje Windows:

• Win95 i Win98, które nie są prawdziwymi systemami wielozadaniowymi i wielowątkowymi. Są to
ostatnie (na szczęście) metamorfozy systemu DOS, co można sprawdzić podczas startu systemu,
wymuszając ładowanie tylko wiersza poleceń: polecenie ver zwróci wtedy np. napis „MS-DOS
7.0”.

• NT, nowy system operacyjny, napisany od podstaw, wyposażony w prawdziwe możliwości
wielozadaniowości i inne zaawansowane cechy.

• Windows 2000, oparty na NT, z wszystkimi cechami zewnętrznymi Win98.

• Windows XP, występujący w odmianach Personal i Pro, jest ostatnim krokiem połączenia cech obu
linii produktów Win9x i NT.
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Win9x mają możliwość uruchamiania jednocześnie programów 16- i 32-bitowych, ale ponieważ sam
system nie jest w całości napisany dla trybu 32-bitowego i nie posiada ochrony pamięci, programy
16-bitowe mogą nadpisywać część pamięci wykorzystywanej przez system! Niektóre elementy systemu,
jak GDI (Graphical Device Interface) zarządzają w sposób ograniczony zasobami (bitmapy, fonty itp.) gdy
wszystkie uruchomione programy jednocześnie korzystają z tych zasobów. Wszystkie nagłówki bitmap
dostępnych w tym samym czasie nie mogą przekroczyć granicy 64KB. Jest to przyczyna spotykanego
często gwałtownego spadku wydajności systemu i jego zawieszania.

NT i W2K i XP nie posiadają takich ograniczeń. Są to systemy w pełni wielozadaniowe i z ochroną
pamięci. Wydają się bardziej stabilne ponieważ lepiej zarządzają pamięcią, posiadają lepszy system plików
itp.

6.10.2. Wiersz poleceń

Wielu użytkowników może zadać pytanie: „po co używać wiersza poleceń w systemie Windows?”. Dobre
pytanie! Problem ma naturę bardziej ogólną. Otóż nie wszystkie zadania daje się wykonać jedynie przy
użyciu interfejsu graficznego (GUI). Wiersz poleceń dostarcza wielu możliwości rasowego programowania
(zakładając posiadanie przyzwoitego interpretera poleceń).

TEX jest programem działającym wsadowo (batch), a nie interakcyjnie: wylicza najlepszy wygląd
każdej strony, rozwiązuje odesłania itp. Taki charakter pracy możliwy jest jedynie podczas globalnego
przetwarzania dokumentu, nie ma tu możliwości interakcji. Oznacza to, że program TEX powinien być
używany z linii poleceń. W istocie nie jest to takie złe. Programy działające wsadowo, przeznaczone do
skomplikowanych zadań, są zwykle lepiej opracowane i pozbawione błędów, ponieważ nie są związane
z graficznym interfejsem. Do uruchamiania takich programów można zawsze opracować graficzny
interfejs przekazujący zadanie do wykonania i inne parametry. Przykładem takiego właśnie działania
może być graficzny edytor (patrz 6.9).

Niemniej jednak częste są sytuacje, gdy przydaje się możliwość uruchamiania programów bezpośred-
nio z linii poleceń, np. diagnostyka błędów w wypadku wystąpienia problemów (patrz 7.2.4).

Win9x linia poleceń dostępna jest z menu Start->Programy->Tryb MS DOS albo Start->Uruchom:
należy tu wpisać command.com.

NT, 2K, XP dostęp do linii poleceń z menu Start->Akcesoria-> Command Prompt; można także
w menu Start->Uruchom wpisać cmd.exe co uruchomi interpreter poleceń (wyjaśnia to dlaczego
trudno w systemach opartych na NT mówić o „oknie DOS”).

6.10.3. Separatory ścieżek

API Win32 obsługuje zarówno /, jak i \ jako separatory ścieżek. Niestety interpretery poleceń obsługują
wyłącznie \, a więc odwołując się do programu w linii poleceń możemy użyć tylko tego znaku (wynika
to z potrzeby kompatybilności: znak / używany jest często jako prefiks dodatkowego parametru). Gdy
nazwa ścieżki jest używana przez program oba separatory mogą być stosowane wymiennie, a nawet
mieszane.

Nie należy się dziwić gdy często spotkamy ścieżki pisane w konwencji Unix (a więc separowane
znakiem /). fpTEX jest implementacją Web2C i z zasady musi być zgodny między różnymi platformami.
Dlatego właśnie np. wszystkie pliki konfiguracyjne stosują konwencję uniksową notacji ścieżek.

6.10.4. System plików

Najgorszą cechą Win9x z punktu widzenia systemu TEX jest prawdopodobnie system plików zwany FAT.
TEX używa bardzo wielu niewielkich plików (1–3KB) i na współczesnych dyskach wielkiej pojemności
każdy taki plik potrafi zająć nawet 32KB. Wykorzystanie dysku jest więc bardzo nieefektywne zaś
instalacja wszystkich plików z CD-ROM-u może zająć wielokrotnie więcej miejsca niż łączna objętość
plików.
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Bardziej nowoczesne systemy plików, takie jak NTFS, dostępne są w nowszych wersjach Windows
i są one pozbawione ujemnych cech FAT: minimalna jednostka alokacji dla pliku to zwykle 4KB, choć
w systemie NTFS można ją zredukować nawet do 512 bajtów.

6.10.5. Jak dodać katalog do zmiennej PATH

Większość programów korzysta ze zmiennych, którym można przypisać pewne wartości. Zestaw takich
przypisań (par zmienna-wartość) nazywamy środowiskiem. Każdy uruchomiony program korzysta z kopii
środowiska i może w ramach tej kopii zmieniać przypisania niektórych zmiennych (nie są one dostępne dla
innych uruchomionych równolegle programów). Instalator systemu TEX dla Win32 konieczną konfigurację
środowiska przeprowadza automatycznie. Warto jednak wiedzieć, jak konfigurować środowisko ręcznie.
PATH jest specjalną zmienną wykorzystywaną do lokalizowania programów w systemie. Poszczególne

wersje Windows mają różne procedury deklarowania PATH:

Windows 95/98 zmienna PATH jest tu deklarowana w pliku autoexec.bat (znajduje się on w głównym
katalogu dysku startowego). Po wczytaniu pliku do edytora (np. Notatnik, WinShell) należy
odszukać wiersz z napisem PATH= i z szeregiem ścieżek oddzielanych separatorem ; (średnik).
Można dopisać kolejne ścieżki wskazujące położenie programów, np.

PATH=c:\windows;c:\windows\system;c:\"Program Files"\TeXlive\bin\win32

Proszę zauważyć, że ścieżki zawierające spację wymagają ujęcia w parę znaków ". Poczynione
zmiany aktywne będą po restarcie systemu.

Windows ME należy uruchomić specjalny program c:\windows\system\msconfig.exe i wybrać
opcję „Środowisko” (‘Environment’). Po dodaniu lub modyfikacji zmiennej należy ponownie
uruchomić system.

Windows NT/2K/XP należy wybrać menu Start -> Settings -> Panel Sterowania, w opcji
„System” otworzyć zakładkę „Zaawansowane”, następnie przycisk „Zmienne środowiskowe” i tu
modyfikować deklaracje zmiennych, zgodnie z posiadanymi uprawnieniami. Istniejącą zmienną
PATH modyfikujemy naciskając lewy klawisz myszy na napisie PATH. Pole „Wartość” (Value)
pokaże listę katalogów rozdzielonych separatorem ;. Należy tu dopisać katalog zawierający
programy środowiska TEX-owego (np. c:\Program Files\TeXlive\bin\win32). Gdy brak jest
zmiennej PATH, należy kliknąć pole „Zmienna”, wpisać PATH, przenieść kursor do pola „Wartość”
i wpisać tu odpowiedni katalog.

Uwaga: przed zamknięciem okna dialogowego należy zatwierdzić zmiany przyciskiem „Zastosuj”.

Dokonane zmiany można sprawdzić otwierając konsolę i uruchamiając polecenie:

set NAZWA_ZMIENNEJ

co wyświetli aktualnie aktywne wartości dla danej zmiennej.

6.10.6. „Maszyny” TEX

Z dokumentacji Web2C można wyczytać, że różnie nazwane programy wykorzystują tę samą „maszynę”,
np. tex.exe i latex.exe są dokładnymi kopiami tego samego programu, ale uruchamiają się z różnymi
plikami formatu, zgodnie z nazwą podaną w wywołaniu.

W systemach Unix cecha ta jest zaimplementowana poprzez tzw. dowiązanie symboliczne, co pozwala
na zaoszczędzenie wiele miejsca na dysku: ten sam program uruchamiany jest z wieloma formatami.

Interfejs aplikacji systemów Windows (API) nie zna pojęcia dowiązania. Aby niepotrzebnie
nie zajmować miejsca na dysku, zastosowano tu pomysł umieszczenia głównej „maszyny” TEX
w pliku dynamicznie wiązanej biblioteki (DLL). Z kolei programy uruchomieniowe (.exe) umieszczono
w niewielkich plikach przekazujących przez nazwę parametr wywołania (nazwę formatu). Na dysku
znajdziemy zatem:
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13/05/2002 17:06 3 584 latex.exe
13/05/2002 17:06 266 240 tex.dll
13/05/2002 17:06 3 584 tex.exe

Każdy z tych identycznych programów (tex.exe, latex.exe, mex.exe itp.) korzysta ze wspólnego
pliku tex.dll. Podobne rozwiązanie zastosowano dla grupy programów mktex*.exe, z których każdy
jest powiązany z biblioteką mktex.dll. W dystrybucji dostępny jest program lnexe.exe, który tworzy
w systemach Win32 odpowiedniki dowiązań systemu Unix.

6.11. W razie problemu
6.11.1. Co zrobić gdy latex nie może znaleźć potrzebnych plików?

Należy użyć programu kpsewhich, który jest narzędziem do diagnostyki wszelkich problemów związanych
ze znajdywaniem plików (patrz 7.2.4 na str. 43.

6.11.2. Co zrobić gdy instalacja nadal nie działa prawidłowo?

Należy odpowiedzieć sobie na szereg pytań:

1. czy program tex.exe jest w ścieżce wymienionej w zmiennej PATH?

2. czy zmienna TEXMFCNF jest prawidłowo ustawiona (standardowo c:/"Program Files"/
TeXlive/texmf-var/web2c)?

3. czy są jakieś błędy w pliku .log utworzonym przez program TeXSetup.exe? W pliku .log
należy wyszukać słowo „Error”.

4. diagnostyka błędów omówiona została w części 7.2.4 na str. 43.

5. opis problemów i ewentualne rozwiązanie oraz poprawki można znaleźć pod adresem http:
//www.tug.org/tex-live.html.

6. dystrybucja dla Windows zawarta na płytce jest w zasadzie identyczna z dystrybucją fpTEX, wobec
tego można odwiedzić stronę http://www.fptex.org; warto też zapisać się na listę dyskusyjną
fpTEX (http://www.tug.org/mailman/listinfo/fptex).

Oprogramowanie zawarte na TEX Live jest bardzo złożone i składa się z ponad 250 programów
i około 40000 plików różnego źródła. Niesłychanie trudno przewidzieć wszystkie możliwe przyczyny
problemów, niemniej jednak dołożymy wszelkich starań aby pomóc je rozwiązać.

6.12. Kompilacja plików źródłowych
Wszystkie pliki źródłowe programów zawarte są w skompresowanym archiwum source/source.tar.
bz2 na CD-ROM-ie. Kompilacja w środowisku Windows wymaga:

• Windows 2000;

• Microsoft Visual Studio .Net 2003;

• zestawu narzędzi Unix (sed, grep, gawk itp.), a także Perl, Flex i Bison;

• dostosowania ścieżek w pliku win32/make/common.mak, zgodnie z konkretną instalacją;

• dostosowania ścieżek w skrypcie perlowym win32/perl/build.pl;

• uruchomienia kompilacji z katalogu mswin32/ poleceniem:

c:\texlive\source\mswin32>perl ./perl/build.pl --install --log=install.log

Uczynienie tego procesu łatwiejszym i bardziej klarownym wymaga jeszcze sporo pracy.

http://www.tug.org/tex-live.html
http://www.tug.org/tex-live.html
http://www.fptex.org
http://www.tug.org/mailman/listinfo/fptex
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7. Instrukcja obsługi systemu Web2C
Web2C to zestaw programów związanych z TEX-em, tj. sam TEX, METAFONT, METAPOST, BibTEX
itp. Oryginalna implementacja wykonana została przez Tomasa Rokickiego, który w roku 1987 stworzył
pierwszy system TEX-to-C, adaptując pliki wymiany (change files) pod Unix-em (pierwotnie były one
dziełem Howarda Trickey’a oraz Pavela Curtisa). W czasie gdy Tim Morgan zajmował się systemem,
jego nazwa została zmieniona na Web-to-C. W 1990 roku prace nad projektem przejął Karl Berry wraz
z dziesiątkami współpracowników, a w roku 1997 pałeczkę przejął Olaf Weber.

Web2C działa na platformach systemowych takich jak Unix (w tym Mac OS X), Windows 9x/NT/2K/XP
i innych. System wykorzystuje oryginalne źródła TEX-owe autorstwa Donalda Knutha oraz inne
programy napisane w web i tłumaczy je na kod źródłowy C. Ponadto system udostępnia spory zestaw
makr i funkcji stworzonych dla zwiększenia funkcjonalności oryginalnych zasobów oprogramowania
związanego z TEX-em. Podstawowymi składnikami systemu są:

bibtex tworzenie spisów bibliograficznych;

dmp konwersja troff do MPX (rysunki METAPOST-owe);

dvicopy modyfikowanie pliku DVI;

dvitomp konwersja DVI do MPX (rysunki METAPOST-owe);

dvitype konwersja DVI na plik tekstowy (ASCII);

gftodvi zamiana fontu GF na plik DVI;

gftopk zamiana fontów w formacie GF na font spakowany PK;

gftype zamiana fontu GF na plik tekstowy (ASCII);

makempx skład etykiet METAPOST-owych;

mf generowanie fontów bitmapowych w formacie GF;

mft skład plików źródłowych METAFONT-a;

mpost tworzenie rysunków oraz diagramów technicznych;

mpto ekstrakcja etykiet METAPOST-owych;

newer porównywanie czasów modyfikacji;

patgen tworzenie wzorców przenoszenia wyrazów;

pktogf zamiana fontów w formacie PK na fonty GF;

pktype zamiana fontu PK na plik tekstowy (ASCII);

pltotf konwersja tekstowej listy właściwości do TFM;

pooltype wyświetlanie web-owych plików pool;

tangle konwersja web do języka Pascal;

tex skład tekstu;

tftopl konwersja TFM do tekstowej listy właściwości (PL);

vftovp konwersja fontów wirtualnych do wirtualnej listy właściwości (VPL);
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vptovf konwersja wirtualnej listy właściwości do fontów wirtualnych;

weave konwersja web do TEX-a.

Dokładny opis funkcji oraz składni tych programów zawarty jest w dokumentacji poszczególnych
pakietów samego Web2C. Jednak do optymalnego wykorzystania instalacji Web2C pomocna będzie
znajomość kilku zasad rządzących całą rodziną programów.

Wszystkie programy obsługują standardowe opcje GNU:

--help podaje podstawowe zasady użytkowania;

--verbose podaje dokładny raport z działania programu;

--version podaje informację o wersji, po czym kończy działanie programu.

W celu lokalizacji plików programy Web2C używają biblioteki do przeszukiwania ścieżek zwanej
Kpathsea. Dla optymalizacji przeszukiwania TEX-owego drzewa podkatalogów biblioteka ta używa
kombinacji zmiennych środowiskowych oraz kilku plików konfiguracyjnych. Web2C potrafi obsługiwać
jednocześnie więcej niż jedno drzewo podkatalogów, co jest użyteczne w przypadku, gdy chce się
przechowywać standardową dystrybucję TEX-a jak i lokalne rozszerzenia w dwóch różnych drzewach
katalogów. Aby przyspieszyć poszukiwanie plików, katalog główny każdego drzewa ma swój plik ls-R,
zawierający pozycje określające nazwę i względną ścieżkę dla wszystkich plików zawartych w tym
katalogu.

7.1. Przeszukiwanie ścieżek przez Kpathsea
Opiszemy najpierw ogólny mechanizm przeszukiwania ścieżek przez bibliotekę Kpathsea.

Tym, co nazywamy ścieżką przeszukiwania jest, rozdzielona dwukropkami lub średnikami, lista
elementów ścieżki, które zasadniczo są nazwami podkatalogów. Ścieżka przeszukiwania może pochodzić
z (kombinacji) wielu źródeł. Przykładowo, aby odnaleźć plik „my-file” w ścieżce „.:/dir”, Kpathsea
sprawdza, czu istnieje dany element ścieżki w następującej kolejności: najpierw ./my-file, potem
/dir/my-file, zwracając pierwszy odnaleziony (lub możliwie wszystkie).

Aby optymalnie zaadaptować się do konwencji wszystkich systemów operacyjnych, na systemach
nieunixowych Kpathsea może używać jako separatorów nazw ścieżek znaków innych niż dwukropek
(„:”) oraz „ciach” („/”).

W celu sprawdzenia konkretnego elementu p ścieżki, Kpathsea najpierw sprawdza, czy zbudowana
wcześniej baza danych (patrz „Baza nazw plików” na stronie 38) odnosi sie do p, tj. czy baza
danych znajduje się w podkatalogu z prefiksem p. Jeżeli tak, to specyfikacja ścieżki jest porównywana
z zawartością bazy.

Jeśli baza danych nie istnieje, lub nie odnosi się do danego elementu ścieżki, albo nie zawiera
elementów zgodnych, przeszukiwany jest system plików (jeżeli nie zostało to zabronione przez
specyfikację rozpoczynającą się od „!!” oraz jeżeli poszukiwany plik musi istnieć). Kpathsea konstruuje
listę podkatalogów, które korespondują z danym elementem ścieżki, a następnie sprawdza w każdym
z nich, czy nie ma tam poszukiwanego pliku.

Warunek mówiący, że „plik musi istnieć” dotyczy np. plików „.vf” i plików dołączanych TEX-owym
poleceniem \openin. Takiego pliku może nie być (np. cmr10.vf), błędne byłoby zatem poszukiwanie
go na dysku. Jeśli więc zapomnisz o aktualizacji ls-R po instalacji nowego pliku „.vf”, nie zostanie on
odnaleziony. Każdy element ścieżki sprawdzany jest w następującej kolejności: najpierw w bazie danych,
potem na dysku. Jeżeli plik się znajdzie, przeszukiwanie zostanie zatrzymane i zwrócony zostanie wynik.

Ponieważ najprostszym i najbardziej powszechnym elementem ścieżki jest nazwa katalogu, Kpathsea
korzysta z dodatkowych możliwości w przeszukiwaniu ścieżek: wielowarstwowych wartości domyślnych,
zmiennych środowiskowych, wartości pliku konfiguracyjnego, lokalnych podkatalogów użytkownika oraz
rekursywnego przeszukiwanie podkatalogów. Można więc powiedzieć, że Kpathsea rozwija element
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ścieżki, tzn. transformuje wszystkie specyfikacje do podstawowej nazwy lub nazw katalogów. Jest to
opisane w kolejnych akapitach, w kolejności, w jakiej ma to miejsce.

Trzeba zauważyć, że jeżeli nazwa poszukiwanego pliku jest absolutna lub jawnie względna, tj. zaczyna
się od „/” lub „./” lub „../”, Kpathsea ogranicza się do sprawdzenia, czy ten plik istnieje.

7.1.1. Źródła ścieżek

Nazwa przeszukiwanej ścieżki może pochodzić z wielu źródeł. Oto kolejność, w jakiej Kpathsea ich
używa:

1. Zmienna środowiskowa ustawiana przez użytkownika, np. TEXINPUTS. Zmienne środowiskowe
z dołączoną kropką i nazwą programu zastępują inne, np. jeżeli „latex” jest nazwą uruchomionego
programu, wtedy zamiast TEXINPUTS wykorzystana zostanie zmienna TEXINPUTS.latex.

2. Plik konfiguracyjny konkretnego programu, np. linia „S /a:/b” w pliku config.ps programu
dvips.

3. Plik konfiguracyjny Kpathsea texmf.cnf, zawierający taką linię, jak „TEXINPUTS=/c:/d” (patrz
poniżej).

4. Wartości domyślne dla uruchamianych programów.

Każdą z tych wartości dla danej ścieżki przeszukiwania można zobaczyć, używając opcji diagnostyki
błędów (patrz „Diagnostyka błędów” na stronie 43).

7.1.2. Pliki konfiguracyjne

Kpathsea szuka ścieżek przeszukiwania i innych definicji w plikach konfiguracyjnych o nazwach
texmf.cnf. Ścieżka przeszukiwania używana do znajdowania tych plików określana jest zmienną
TEXMFCNF (domyślnie taki plik znajduje się w podkatalogu texmf/web2c). Czytane będą wszystkie pliki
texmf.cnf w ścieżce przeszukiwania, a definicje we wcześniejszych plikach zastąpią te w późniejszych.
Tak więc w ścieżce .:$TEXMF, wartości pochodzące z ./texmf.cnf zastąpią te z $TEXMF/texmf.cnf.

Dociekliwy czytelnik może być zainteresowany jak same programy znajdują plik texmf.cnf, skoro
nie jest obowiązkowe deklarowanie specyficznej zmiennej środowiskowej systemu. Otóż położenie
domyślne jest wkompilowane w programy jako względne do ich położenia (określanego, jak wiemy,
w ścieżce specyfikowanej przez $PATH): ../../texmf/web2c/ bądź ../texmf/web2c/. Jeśli jawnie
deklarujemy zmienną TEXMFCNF, wymagane jest podanie bezwzględnej ścieżki.

Czytając zamieszczony poniżej opis formatu pliku texmf.cnf warto przeglądać jego zawartość.
Położenie aktywnego pliku znajdziemy za pomocą polecenia kpsewhich texmf.cnf.

• Komentarze zaczynają się od „%”, a kończą na końcu wiersza.

• Puste wiersze nie są brane pod uwagę.

• Znak \ na końcu wiersza działa jako znak kontynuacji, tzn. oznacza, że kolejny wiersz jest
kontynuacją bieżącego. Spacja na początku kolejnego wiersza nie jest ignorowana.

• Pozostałe wiersze mają postać:

zmienna [.program ] [=] wartość

gdzie „=” i otaczające spacje są opcjonalne.

• „zmienna ” zawierać może dowolne znaki poza spacją, „=”, lub „.” (kropką), najbezpieczniej jest
jednak używać znaków z zakresu „A-Za-z ”.
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• Napis „.program ” ma zastosowanie w wypadku, gdy uruchamiany program nosi nazwę program
lub program.exe. Pozwala to różnym odmianom TEX-a posiadać różne ścieżki przeszukiwania.

• „wartość ” zawierać może dowolne znaki poza „%” oraz „@”. Nie można używać konstrukcji
„$zmienna.program ” po prawej stronie. Zamiast tego trzeba zastosować zmienną pomocniczą.
Średnik „;” użyty w „wartość ” zamieniany jest na „:” jeżeli systemem operacyjnym jest Unix;
umożliwia to posiadanie jednego pliku texmf.cnf dla systemów Unix oraz Windows.

• Wszystkie definicje czytane są zanim cokolwiek zostanie rozwinięte, tak więc do zmiennych
odwoływać się można przed ich zdefiniowaniem.

Fragment pliku konfiguracyjnego ilustrujący większość powyższych cech pokazany jest poniżej:

TEXMF = {$TEXMFLOCAL;!!$TEXMFMAIN}
TEXINPUTS.latex = .;$TEXMF/tex/{latex;generic;}//
TEXINPUTS.fontinst = .;$TEXMF/tex//;$TEXMF/fonts/afm//
% e-TeX related files
TEXINPUTS.elatex = .;$TEXMF/{etex;tex}/{latex;generic;}//
TEXINPUTS.etex = .;$TEXMF/{etex;tex}/{eplain;plain;generic;}//

7.1.3. Rozwijanie ścieżek

Kpathsea rozpoznaje w ścieżkach przeszukiwania pewne specjalne znaki oraz konstrukcje, podobne do
tych, dostępnych w powłokach Unixa. Jako ogólny przykład: złożona ścieżka ~$USER/{foo,bar}//baz
rozwija się do wszystkich podkatalogów pod katalogami foo i bar w katalogu głównym $USER, które
zawierają katalog lub plik baz. Rozwinięcia te opisane są w poniższych podrozdziałach.

7.1.4. Rozwijanie domyślne

Jeżeli ścieżka przeszukiwania największego uprzywilejowania (patrz „Źródła ścieżek” na stronie 36)
zawiera dodatkowy dwukropek (np. na początku, na końcu lub podwójny) to Kpathsea wstawia w tym
miejscu następną zdefiniowaną w hierarchii uprzywilejowania ścieżkę przeszukiwania. Jeżeli ta wstawiona
ścieżka ma dodatkowy dwukropek, dzieje się dalej to samo. Przykładowo, jeżeli ustawić zmienną
środowiskową

> setenv TEXINPUTS /home/karl:

oraz wartość TEXINPUTS pobraną z texmf.cnf

.:$TEXMF//tex

końcową wartością użytą w przeszukiwaniu będzie:

/home/karl:.:$TEXMF//tex

Ponieważ nieużytecznym byłoby wstawiać wartość domyślną w więcej niż jedno miejsce, Kpathsea
zmienia tylko jeden dodatkowy „:” i pozostawia inne bez zmian; najpierw szuka dwukropków na początku
linii, potem na końcu, a następnie podwójnych.

7.1.5. Rozwijanie nawiasów

Użyteczną cechą jest możliwość rozwijania nawiasów, co oznacza, że np. v{a,b}w rozwija się do
vaw:vbw. Możliwe jest zagnieżdżanie nawiasów. Funkcja ta może być użyta do zaimplementowania
różnych hierarchii TEX-owych przez przypisanie listy nawiasów do $TEXMF. Przykładowo, w pliku
texmf.cnf znaleźć można następującą definicję:

TEXMF = {$HOMETEXMF,$TEXMFLOCAL,!!$VARTEXMF,!!$TEXMFMAIN}
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Używając jej można następnie napisać coś w rodzaju

TEXINPUTS = .;$TEXMF/tex//

co oznacza, że po szukaniu w katalogu bieżącym przeszukane będą kolejno $HOMETEXMF/tex,
$TEXMFLOCAL/tex, $VARTEXMF/tex i $TEXMFMAIN/tex (wszystkie wraz z katalogami niższego
poziomu; dwie ostatnie ścieżki wyłącznie na podstawie zawartości pliku ls-R). Jest to wygodny sposób
dla uruchamiania dwóch równoległych struktur TEX-owych, jednej „zamrożonej” (np. na CD-ROM-ie),
a drugiej ciągle uaktualnianej nowymi, pojawiającymi się wersjami. Używając zmiennej $TEXMF we
wszystkich definicjach, jest się pewnym, że najpierw przeszukiwane jest drzewo uaktualnione.

7.1.6. Rozwijanie podkatalogów

Dwa lub więcej kolejnych „ciachów” („/”) w elemencie ścieżki, występujących po nazwie katalogu d,
zastępowany jest przez wszystkie podkatalogi d: najpierw podkatalogi znajdujące się bezpośrednio pod d,
potem te pod powyższymi i tak dalej. Na każdym etapie kolejność, w jakiej przeszukiwane są katalogi,
jest nieokreślona.

Jeśli wyszczególni się człony nazwy pliku po „//”, uwzględnione zostaną tylko te podkatalogi, które
zawierają powyższe człony. Na przykład „/a//b” rozwija się do katalogów /a/1/b, /a/2/b, /a/1/1/b
itd., ale nie do /a/b/c czy /a/1.

Możliwe jest wielokrotne użycie „//” w ścieżce, jednakże „//” występujące na początku ścieżki nie
jest brane pod uwagę.

7.1.7. Lista znaków specjalnych i ich znaczeń – podsumowanie

Poniższa lista podsumowuje znaczenie znaków specjalnych w plikach konfiguracyjnych.

: znak rozdzielający w specyfikacji ścieżki; umieszczony na początku lub na końcu ścieżki zastępuje
domyślne rozwinięcie ścieżki;

; znak rozdzielający dla systemów nieUnix-owych (działa tak jak :);

$ rozwijanie zmiennej;

~ oznacza katalog główny użytkownika;

{...}rozwijanie nawiasów, np. a{1,2}b zmieni się w a1b:a2b;

// rozwijanie podkatalogów (może wystąpić gdziekolwiek w ścieżce, poza jej początkiem);

% początek komentarza;

\ znak kontynuacji (pozwala na przełamanie wiersza z wyrażeniem);

!! przeszukiwanie tylko bazy danych, a nie dysku.

7.2. Bazy nazw plików
Dla celów przeszukiwania Kpathsea stara się zminimalizować dostęp do dysku. Niemniej jednak,
w przypadku instalacji ze zbyt dużą liczbą katalogów, przeglądanie każdego możliwego katalogu
w poszukiwaniu danego pliku może zabierać sporo czasu (ma to miejsce zwłaszcza, jeżeli przeszukać
trzeba setki katalogów z fontami). Dlatego też Kpathsea może używać zewnętrznego pliku z „bazą
danych” o nazwie ls-R, który to zawiera przypisania plików do katalogów. Unika się w ten sposób
potrzeby wyczerpującego przeszukiwania dysku.

Drugi plik z bazą danych – aliases – pozwala na nadawanie dodatkowych nazw plikom zawartym
w ls-R. Może to być pomocne do adaptacji do DOS-owej konwencji „8.3” nazewnictwa plików w plikach
źródłowych.
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7.2.1. Baza nazw plików

Jak to wytłumaczono powyżej, plik zawierający główną bazę nazw plików musi nosić nazwę ls-R.
W katalogu podstawowym każdej hierarchii TEX-owej (domyślnie $TEXMF), którą chcemy włączyć
w mechanizm przeszukiwania, umieszczać można po jednym pliku ls-R; w większości przypadków
istnieje tylko jedna hierarchia. Kpathsea szuka pliku ls-R w ścieżce TEXMFDBS.

Najlepszym sposobem stworzenia i utrzymywania pliku ls-R jest uruchomienie skryptu mktexlsr,
będącego składnikiem dystrybucji. Jest on wywoływany przez różne skrypty typu „mktex...”.
W zasadzie skrypt ten jedynie wykonuje polecenie

cd /your/texmf/root && ls -LAR ./ >ls-R

zakładając, że polecenie ls danego systemu utworzy właściwy format strumienia wyjściowego (GNU
ls działa prawidłowo). Aby mieć pewność, że baza danych jest zawsze aktualna, wygodnie jest
przebudowywać ją regularnie za pomocą demona cron.

Jeśli pliku nie ma w bazie danych, Kpathsea domyślnie przechodzi do przeszukiwania dysku. Jeżeli
jednak dany element ścieżki zaczyna sie od „!!”, w poszukiwaniu tego elementu sprawdzona zostanie
jedynie baza danych, a nigdy dysk.

7.2.2. kpsewhich – program do przeszukiwania ścieżek

Przeszukiwanie ścieżek przez program kpsewhich jest niezależne od jakiejkolwiek aplikacji. Może on
być przydatny jako rodzaj programu find, za pomocą którego lokalizować można pliki w hierarchiach
TEX-owych (jest on używany intensywnie w skryptach „mktex...” tej dystrybucji).

> kpsewhich opcje ... nazwa-pliku ...

Parametry wyszczególnione w „opcje ” mogą zaczynać się zarówno od „-” jak i od „--”, i dozwolony
jest każdy jednoznaczny skrót.

Kpathsea traktuje każdy argument nie będący parametrem jako nazwę pliku i zwraca pierwszą
odnalezioną nazwę. Nie ma parametru nakazującego zwracanie wszystkich nazw plików o określonej
nazwie (w tym celu można wykorzystać Unix-owy program „find”).

Ważniejsze parametry opisane są poniżej.

--dpi=num Ustaw rozdzielczość na „num ”; ma to tylko wpływ na przeszukiwanie fontów „gf” i „pk”.
Dla zgodności z dvips parametr „-D” działa identycznie. Domyślną wartością jest 600.

--format=nazwa
Ustawienie formatu (typu pliku) przeszukiwania na „nazwa ”. Domyślnie format odgadywany jest
z nazwy pliku. Dla formatów, które nie mają przydzielonego jednoznacznego rozszerzenia, takich
jak niektóre pliki METAPOST-owe, czy pliki konfiguracyjne dvips-a, należy wyszczególnić nazwę,
którą znaleźć można w pierwszej kolumnie tabeli 2. Zawiera ona spis aktualnie rozpoznawanych
nazw, opis, przypisane zmienne środowiskowe (ich definicje znaleźć można w pliku texmf.cnf)
oraz możliwe rozszerzenia nazw.

Tabela 2: Typy plików Kpathsea

Nazwa Opis Zmienne Rozszerzenia
afm Metryki czcionek Adobe AFMFONTS .afm
base Bazy (formaty) Metafonta MFBASES, TEXMFINI .base
bib Źródła bibliograficzne BibTEX-a BIBINPUTS, TEXBIB .bib
bst Pliki stylu BibTEX BSTINPUTS .bst

fonty bitmapowe GLYPHFONTS, TEXFONTS
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Typy plików Kpathsea cd.
Nazwa Opis Zmienne Rozszerzenia
cnf Pliki konfiguracyjne TEXMFCNF .cnf
dvips config Pliki konfiguracyjne Dvips, np.

config.ps i psfonts.map
TEXCONFIG .map

fmt Formaty TEX-a TEXFORMATS, TEXMFINI .fmt, .efmt,
.efm

gf fonty GF (bitmapowe) GFFONTS .gf
graphic/figure Rysunki w formacie EPS TEXPICTS, TEXINPUTS .eps, .epsi
ist Pliki stylów makeindex TEXINDEXSTYLE, INDEXSTYLE .ist
ls-R Bazy nazw plików TEXMFDBS

map Mapy fontowe TEXFONTMAPS .map
mem Bazy METAPOST-owe MPMEMS, TEXMFINI .mem
mf Pliki źródłowe METAFONT-a MFINPUTS .mf
mfpool pliki napisów METAFONT-a MFPOOL, TEXMFINI .pool
mft Pliki stylu MFT MFTINPUTS .mft

fonty inne MISCFONTS

mp Pliki źródłowe METAPOST-a MPINPUTS .mp
mppool pliki napisów METAPOST-a MPPOOL, TEXMFINI .pool
MetaPost
support

pliki pomocnicze METAPOST-a,
wykorzystywane przez DMP

MPSUPPORT

ocp Ω – skompilowane pliki
pomocnicze

OCPINPUTS .ocp

ofm Metryki fontów Ω OFMFONTS, TEXFONTS .ofm, .tfm
opl Ω – listy właściwości OPLFONTS, TEXFONTS .opl
otp Ω – pliki przekodowań OTPINPUTS .otp
ovf Fonty wirtualne Ω OVFFONTS, TEXFONTS .ovf
ovp Wirtualne listy właściwości Ω OVPFONTS, TEXFONTS .ovp
pk Fonty spakowane (PK) program FONTS (gdzie program to

XDVI, etc.), PKFONTS, TEXPKS,
GLYPHFONTS, TEXFONTS

.pk

PostScript
header

Ładowalne programy
PostScript-owe

TEXPSHEADERS, PSHEADERS .pro, .enc

tex Pliki źródłowe dla TEX-a TEXINPUTS .tex, .cls,
.sty, .clo,
.def

TeX system
documentation

Dokumentacja systemu TEX TEXDOCS

TeX system
sources

Pliki źródłowe systemu TEX TEXSOURCES

texpool pliki napisów TEX-a TEXPOOL, TEXMFINI .pool
tfm Metryki fontów TEX-owych TFMFONTS, TEXFONTS .tfm
Troff fonts Fonty dla Troff, używane przez

DMP
TRFONTS

truetype fonts Fonty TrueType TTFONTS .ttf, .ttc
type1 fonts Fonty Type 1 (PostScript-owe) T1FONTS, T1INPUTS,

TEXPSHEADERS, DVIPSHEADERS
.pfa, .pfb

type42 fonts Fonty Type 42 (PostScript-owe) T42FONTS

vf Fonty wirtualne VFFONTS, TEXFONTS .vf
web2c files Pomocnicze pliki Web2C WEB2C

other text
files

Pliki tekstowe używane przez foo FOOINPUTS

other binary
files

Pliki binarne używane przez foo FOOINPUTS
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Ostatnie dwie pozycje w tabeli 2 to przypadki szczególne, gdzie ścieżki i zmienne środowiskowe
zależą od nazwy programu: nazwa zmiennej budowana jest poprzez zapisanie nazwy programu
wersalikami a następnie dodanie INPUTS.

Zmienne środowiskowe domyślnie ustawiane są w pliku konfiguracyjnym texmf.cnf. W wypadku
gdy chce się unieważnić wartości zmiennych wyszczególnione w tym pliku, można narzucić ich
ustawienie w środowisku, w którym uruchamiane są programy.

Zauważyć trzeba, że parametry „--format” oraz „--path” wzajemnie się wykluczają.

--mode=napis
Ustaw nazwę trybu na „napis ”; dotyczy to jedynie szukania fontów „gf” oraz „pk”. Brak jest
wartości domyślnej – odnaleziony zostanie dowolny wyszczególniony tryb.

--must-exist
Zrób wszystko co możliwe aby odnaleźć pliki, włączając w to przede wszystkim przeszukanie
dysku. Domyślnie, w celu zwiększeniu efektywności działania, sprawdzana jest tylko baza ls-R.

--path=napis
Szukaj w ścieżce „napis ” (rozdzielonej, jak zwykle, dwukropkami), zamiast zgadywać ścieżkę
przeszukiwania z nazwy pliku. „//” i wszystkie zwykłe rozszerzenia są możliwe. Parametry
„--path” oraz „--format” wzajemnie się wykluczają.

--progname=nazwa
Ustaw nazwę programu na „nazwa ”. Może to mieć wpływ na ścieżkę przeszukiwania poprzez
„.program ” w plikach konfiguracyjnych. Ustawieniem domyślnym jest „kpsewhich”.

--show-path=nazwa
Pokazuje ścieżkę używaną do poszukiwania plików typu „nazwa ”. Użyte może być zarówno
rozszerzenie („.pk”, „.vf”, etc.), jak i nazwa pliku, tak jak w przypadku parametru „--format”.

--debug=num
ustawia parametry wykrywania błędów na „num ”.

7.2.3. Przykłady użycia

Przyjrzyjmy sie teraz jak działa Kpathsea.

> kpsewhich article.cls
/usr/local/texmf/tex/latex/base/article.cls

Szukamy pliku article.cls. Ponieważ rozszerzenie „.cls” jest jednoznaczne, nie musimy zaznaczać,
że poszukujemy pliku typu „tex” (katalogi plików źródłowych TEX-a). Znajdujemy go w podkatalogu
tex/latex/base pod katalogiem nadrzędnym „TEXMF”. Podobnie wszystkie poniższe pliki odnajdywane
są bezproblemowo dzięki swoim jednoznacznym rozszerzeniom.

> kpsewhich array.sty
/usr/local/texmf/tex/latex/tools/array.sty
> kpsewhich latin1.def
/usr/local/texmf/tex/latex/base/latin1.def
> kpsewhich size10.clo
/usr/local/texmf/tex/latex/base/size10.clo
> kpsewhich small2e.tex
/usr/local/texmf/tex/latex/base/small2e.tex
> kpsewhich tugboat.bib
/usr/local/texmf/bibtex/bib/beebe/tugboat.bib



7 INSTRUKCJA OBSŁUGI SYSTEMU Web2C 42

Ostatni plik to BibTEX-owa baza bibliograficzna dla artykułów TUGBoat.

> kpsewhich cmr10.pk

Pliki czcionek bitmapowych typu .pk używane są przez sterowniki takie jak dvips oraz xdvi. W tym
wypadku nie zostaną zwrócone żadne rezultaty przeszukiwania, ponieważ w systemie brak gotowych
wygenerowanych czcionek „.pk” Computer Modern (wynika to z faktu używania na CD-ROM-ie fontów
PostScript-owych Type1).

> kpsewhich ecrm1000.pk

/usr/local/texmf/fonts/pk/ljfour/jknappen/ec/ecrm1000.600pk

Dla rozszerzonych plików Computer Modern musieliśmy wygenerować pliki „.pk”, a ponieważ
domyślnym METAFONT-owym trybem naszej instalacji jest ljfour z podstawową rozdzielczością
600dpi, zwracany jest taki właśnie rezultat.

> kpsewhich -dpi=300 ecrm1000.pk

W tym wypadku, kiedy zaznaczamy, że interesujemy się rozdzielczością 300dpi (-dpi=300) widzimy,
że taka czcionka nie jest dostępna w naszej instalacji. Program taki jak dvips czy xdvi zatrzymałby się
aby utworzyć pliki .pk w wymaganej rozdzielczości (używając skryptu mktexpk).

Zwrócimy teraz naszą uwagę na pliki nagłówkowe i konfiguracyjne programu dvips. Najpierw
szukamy pliku PostScript-owego prologu tex.pro, wykorzystywanego dla potrzeb TEX-a. Drugi przykład
pokazuje poszukiwanie pliku konfiguracyjnego config.ps, zaś trzeci – szukanie pliku mapy czcionek
PostScriptowych psfonts.map. Jako, że rozszerzenie „.ps” nie jest jednoznaczne, musimy zaznaczyć
wyraźnie jaki typ jest wymagany dla pliku config.ps („dvips config”).

> kpsewhich tex.pro
/usr/local/texmf/dvips/base/tex.pro
> kpsewhich --format="dvips config" config.ps
/usr/local/texmf/config/config.ps
> kpsewhich psfonts.map
/usr/local/texmf/dvips/base/psfonts.map

Teraz przyjrzyjmy się bliżej plikom pomocniczym fontów Quasi Times (zawierają one m.in. poprawne
polskie znaki diakrytyczne). Pierwszy plik, którego szukamy to plik konfiguracyjny, zawierający nazwę
pliku z przemapowaniem fontów:

> kpsewhich --format="dvips config" config.qtm
/usr/local/texmf/dvips/qfonts/config.qtm

W pliku tym znajduje się wiersz

p +qtm.map

wskazujący na plik qtm.map, który chcemy zlokalizować w następnej kolejności.

> kpsewhich --format="dvips config" qtm.map
/usr/local/texmf/dvips/qfonts/qtm.map

Plik z przemapowaniem definiuje nazwy czcionek PostScriptowych Type1 w zestawie fontów Quasi
Times, zaś jego zawartość wygląda następująco (pokazane są tylko fragmenty linii):

qtmr QuasiTimes-Regular ... <qtmr.pfb
qtmri QuasiTimes-Italic ... <qtmri.pfb
qtmb QuasiTimes-Bold ... <qtmb.pfb
qtmbi QuasiTimes-BoldItalic ... <qtmbi.pfb
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Używając przeszukiwania plików z fontami Type1 znajdźmy font QuasiTimes-Regular qtmr.pfb
w drzewie katalogów texmf,

> kpsewhich qtmr.pfb

/usr/local/texmf/fonts/type1/qfonts/qtmr.pfb

Powyższe przykłady pokazują, jak łatwo można znajdować lokalizację danego pliku. Ważne jest to
zwłaszcza, gdy istnieje podejrzenie, że gdzieś zawieruszyła się zła wersja jakiegoś pliku; kpsewhich
pokaże tylko pierwszy napotkany plik.

7.2.4. Diagnostyka błędów

Czasami niezbędne są informacje o tym, jak program radzi sobie z odniesieniami do plików. Aby dało
się to wykonywać w wygodny sposób, Kpathsea oferuje różne poziomy diagnostyki błędów:

1 wywołania stat (testy pliku). Podczas uruchamiania z uaktualnioną bazą danych ls-R nie powinno
to przeważnie dawać żadnego wyniku.

2 Zapis odwołań do tablic asocjacyjnych (hash tables), takich jak baza ls-R, pliki przemapowań,
pliki konfiguracyjne.

4 Operacje otwarcia i zamknięcia pliku.

8 Ogólne informacje o ścieżkach dla typów plików szukanych przez Kpathsea; użyteczne dla
znalezienia ścieżki zdefiniowanej dla danego pliku.

16 Lista katalogów dla każdego z elementów ścieżki (odnosi się tylko do poszukiwań na dysku).

32 Poszukiwania plików.

Wartość -1 ustawia wszystkie powyższe opcje: w praktyce, potrzebując wykryć przyczyny błędów,
prawdopodobnie zawsze używać będziesz tych poziomów.

Podobnie, w przypadku programu dvips, ustawiając kombinację przełączników wykrywania błędów,
można dokładnie śledzić skąd pochodzą pliki. W wypadku gdy plik nie zostanie odnaleziony, widać,
w których katalogach program szukał danego pliku, dzięki czemu można się zorientować w czym
problem.

Ogólnie mówiąc, ponieważ programy odwołują się wewnętrznie do biblioteki Kpathsea, opcje
wykrywania błędów wybrać można przy użyciu zmiennej środowiskowej KPATHSEA DEBUG, ustawiając
ją na opisaną powyżej wartość (kombinację wartości).
Uwaga dla użytkowników Windows: w systemie tym niełatwo jest przekierować komunikaty programu
do pliku. Do celów diagnostycznych można w tym celu ustawić chwilowo zmienne (w oknie DOS/CMD):

SET KPATHSEA_DEBUG_OUTPUT=err.log
SET KPATHSEA_DEBUG=-1

Rozważmy na przykład mały LATEX-owy plik źródłowy hello-world.tex, który zawiera co
następuje:

\documentclass{article}
\begin{document}
Hello World!
\end{document}

Ten mały plik używa jedynie fontu cmr10. Przyjrzyjmy się jak dvips przygotowuje plik PostScript-owy
(chcemy użyć wersji Type1 fontu Computer Modern, stąd opcja -Pcms).
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debug:start search(file=texmf.cnf, must_exist=1, find_all=1,
path=.:/usr/local/bin/texlive:/usr/local/bin:

/usr/local/bin/texmf/web2c:/usr/local:
/usr/local/texmf/web2c:/.:/./teTeX/TeX/texmf/web2c:).

kdebug:start search(file=ls-R, must_exist=1, find_all=1,
path=~/tex:/usr/local/texmf).
kdebug:search(ls-R) =>/usr/local/texmf/ls-R
kdebug:start search(file=aliases, must_exist=1, find_all=1,
path=~/tex:/usr/local/texmf).
kdebug:search(aliases) => /usr/local/texmf/aliases
kdebug:start search(file=config.ps, must_exist=0, find_all=0,
path=.:~/tex:!!/usr/local/texmf/dvips//).
kdebug:search(config.ps) => /usr/local/texmf/dvips/config/config.ps
kdebug:start search(file=/root/.dvipsrc, must_exist=0, find_all=0,
path=.:~/tex:!!/usr/local/texmf/dvips//).
search(file=/home/goossens/.dvipsrc, must_exist=1, find_all=0,
path=.:~/tex/dvips//:!!/usr/local/texmf/dvips//).
kdebug:search($HOME/.dvipsrc) =>
kdebug:start search(file=config.cms, must_exist=0, find_all=0,
path=.:~/tex/dvips//:!!/usr/local/texmf/dvips//).
kdebug:search(config.cms)
=>/usr/local/texmf/dvips/cms/config.cms

Rysunek 7: Szukanie pliku konfiguracyjnego

kdebug:start search(file=texc.pro, must\_exist=0, find\_all=0,
path=.:~/tex/dvips//:!!/usr/local/texmf/dvips//:

~/tex/fonts/type1//:!!/usr/local/texmf/fonts/type1//).
kdebug:search(texc.pro) => /usr/local/texmf/dvips/base/texc.pro

Rysunek 8: Szukanie pliku prologu

kdebug:start search(file=cmr10.tfm, must\_exist=1, find\_all=0,
path=.:~/tex/fonts/tfm//:!!/usr/local/texmf/fonts/tfm//:

/var/tex/fonts/tfm//).
kdebug:search(cmr10.tfm) => /usr/local/texmf/fonts/tfm/public/cm/cmr10.tfm
kdebug:start search(file=texps.pro, must\_exist=0, find\_all=0,
...

<texps.pro>
kdebug:start search(file=cmr10.pfb, must\_exist=0, find\_all=0,
path=.:~/tex/dvips//:!!/usr/local/texmf/dvips//:

~/tex/fonts/type1//:!!/usr/local/texmf/fonts/type1//).
kdebug:search(cmr10.pfb) => /usr/local/texmf/fonts/type1/public/cm/cmr10.pfb
<cmr10.pfb>[1]

Rysunek 9: Szukanie pliku fontu

> dvips -d4100 hello-world -Pcms -o

Mamy tu do czynienia jednocześnie z czwartą klasą wykrywania błędów programu dvips (ścieżki fontowe)
oraz z rozwijaniem elementu ścieżki przez Kpathsea (patrz Dvips Reference Manual, texmf/doc/html/
dvips/dvips_toc.html). Komunikaty z uruchomienia programu (lekko zmodyfikowane) znajdują się
na rys. 7. Program dvips zaczyna pracę od zlokalizowania potrzebnych mu plików. Najpierw znajduje plik
texmf.cnf, który zawiera ścieżki przeszukiwania dla innych plików. Potem znajduje bazę danych ls-R
(dla optymalizacji szukania plików), następnie plik aliases, który umożliwia deklarowanie różnych nazw

file:../../../../texmf/doc/html/dvips/dvips_toc.html
file:../../../../texmf/doc/html/dvips/dvips_toc.html
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(np. krótkie DOS-owe „8.3” i bardziej naturalne dłuższe wersje) dla tych samych plików. Następnie dvips
znajduje podstawowy plik konfiguracyjny config.ps, zanim poszuka pliku z ustawieniami użytkownika
.dvipsrc (który w tym wypadku nie zostaje odnaleziony). W końcu dvips lokalizuje plik konfiguracyjny
config.cms dla fontów PostScript-owych Computer Modern (jest to inicjowane przez dodanie parametru
-Pcms przy uruchamianiu programu). Plik ten zawiera listę plików z „mapami”, które definiują relacje
pomiędzy TEX-owymi, PostScript-owymi i systemowymi nazwami fontów.

> more /usr/local/texmf/dvips/config/config.cms
p +bsr.map
p +bakomaextra.map

W ten sposób dvips wyszukuje wszystkie te pliki oraz główny plik z przemapowaniem psfonts.map,
który ładowany jest domyślnie (zawiera on deklaracje często używanych fontów PostScript-owych; więcej
szczegółów odnośnie PostScript-owych plików przemapowań fontów można znaleźć w ostatniej części
rozdziału 7.2.3).

W tym miejscu dvips zgłasza się użytkownikowi:

This is dvips 5.86 Copyright 1999 Radical Eye Software (www.radicaleye.com)

. . . potem szuka pliku prologu texc.pro,

kdebug:start search(file=texc.pro, must exist=0, find all=0,
path=.:~/tex/dvips//:!!/usr/local/texmf/dvips//:

~/tex/fonts/type1//:!!/usr/local/texmf/fonts/type1//).
kdebug:search(texc.pro) => /usr/local/texmf/dvips/base/texc.pro

Po znalezieniu szukanego pliku, dvips podaje datę i czas oraz informuje o generowaniu pliku
hello-world.ps. Ponieważ potrzebuje pliku z fontem cmr10, a jest on zadeklarowany jako dostępny,
wyświetla komunikat:

TeX output 1998.02.26:1204’ -> hello-world.ps
Defining font () cmr10 at 10.0pt
Font cmr10 <CMR10> is resident.

Teraz trwa poszukiwanie pliku cmr10.tfm, który zostaje znaleziony, a następnie dvips powołuje się na
kilka innych plików startowych (nie pokazanych). W końcu przykładowy font Type1 cmr10.pfb zostaje
zlokalizowany i dołączony do pliku wynikowego (patrz ostatnia linia).

kdebug:start search(file=cmr10.tfm, must exist=1, find all=0,
path=.:~/tex/fonts/tfm//:!!/usr/local/texmf/fonts/tfm//:

/var/tex/fonts/tfm//).
kdebug:search(cmr10.tfm) => /usr/local/texmf/fonts/tfm/public/cm/cmr10.tfm
kdebug:start search(file=texps.pro, must exist=0, find all=0,
...

<texps.pro>
kdebug:start search(file=cmr10.pfb, must exist=0, find all=0,
path=.:~/tex/dvips//:!!/usr/local/texmf/dvips//:

~/tex/fonts/type1//:!!/usr/local/texmf/fonts/type1//).
kdebug:search(cmr10.pfb) => /usr/local/texmf/fonts/type1/public/cm/cmr10.pfb
<cmr10.pfb>[1]

7.3. Parametry kontrolujące działanie programów
Inną użyteczną cechą Web2C jest możliwość ustalania wielu parametrów określających wielkość pamięci
za pomocą pliku texmf.cnf. Ustawienia wszystkich parametrów znajdują się w części trzeciej pliku.
Najważniejszymi zmiennymi są:
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main memory Całkowita wielkość pamięci dostępnej dla TEX-a, METAFONT-a i METAPOST-a.
Dla każdego nowego ustawienia tej zmiennej należy wykonać nowy format. Przykładowo,
możesz wygenerować „ogromną” wersję formatu TEX i nazwać taki plik hugetex.fmt. Dzięki
standardowemu sposobowi nazywania programów przez Kpathsea, określona wartość zmiennej
main_memory będzie przeczytana z pliku texmf.cnf (por. wartość standardową oraz wartość
„ogromną”, wykorzystywaną przez program hugetex, itd.).

extra mem bot Dodatkowa wielkość pamięci przeznaczona na „duże” struktury danych TEX-a, takie
jak: pudełka, kleje itd.; przydatna, zwłaszcza w przypadku korzystania z pakietu PICTEX.

font mem size Wielkość pamięci przeznaczona przez TEX-a na informacje o fontach. Jest to mniej
więcej ogólna wielkość wczytywanych przez TEX-a plików TFM.

hash extra Dodatkowa wielkość pamięci przeznaczona na tablicę zawierającą nazwy instrukcji. Tablica
główna może zmieścić w przybliżeniu 10000 nazw; wielkość ta może okazać się zbyt mała,
np. w wypadku obszernej książki zawierającej liczne odsyłacze. Odpowiednie wiersze pliku
texmf.cnf pokazują, że uruchomienie programów hugetex i pdflatex wymaga dodatkowej pamięci
na 15000 nazw instrukcji.

Oczywiście, powyższa możliwość nie zastąpi prawdziwej, dynamicznej alokacji pamięci. Jest to jednak
niezwykle trudne do zaimplementowania w obecnej wersji TEX-a i dlatego powyższe parametry stanowią
praktyczny kompromis, pozwalając na pewną elastyczność.

8. Budowa systemu na nowej platformie Unixowej
Jeżeli mamy do czynienia z platformą, dla której nie są dostarczone binaria, trzeba będzie skompilować
TEX-a oraz towarzyszące mu programy. Nie jest to takie trudne jak się wydaje. Wszystko, czego
potrzebujemy, znajduje się na CD-ROM-ie w katalogu source.

Najpierw należy zainstalować główne drzewo plików TEX-owych z CD-ROM-u TEX Live (najlepiej
jest wykonać instalację podstawową, bez wybierania binariów systemowych).

8.1. Warunki wstępne
Do skompilowanie całego TEX-a i jego programów pomocniczych potrzeba około 100 megabajtów
wolnego miejsca na dysku. Potrzebny jest także kompilator ANSI C, oprogramowanie make, skaner
leksykalny oraz generator parserów. Programy użytkowe GNU (gcc, GNU make, m4, flex, bison) są
najlepiej przetestowanymi na różnych platformach. Prawidłowo powinny pracować gcc-2.7.*, flex-2.4.7
i GNUmake-3.72.1 lub nowszy. Istnieje możliwość pracy z innymi kompilatorami C i programami make,
wymaga to jednak dobrego zrozumienia zasad tworzenia programów Unixowych, aby poradzić sobie
z problemami.

8.2. Konfiguracja
Należy rozpakować źródła ze skompresowanego pliku tar z katalogu source na twardy dysk, a potem
przejść do katalogu, do którego zostały skopiowane. Teraz trzeba zdecydować się, gdzie będzie główny
katalog instalacji, np. /usr/TeX lub /usr/local/TeX. Naturalnie, należy użyć tej samej lokalizacji,
która została wykorzystana przy instalowaniu głównego drzewa TEX-owego.

Uruchomić configure z linii poleceń:

> ./configure --prefix=/usr/local/TeX

Katalog „prefix” to ten, w którym zainstalowane zostało główne drzewo TEX-owe. Zostanie
wykorzystany następujący układ katalogów ($TEXDIR oznacza wybrany powyżej katalog):
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$TEXDIR/man strony manuala Unixowego,
$TEXDIR/share/texmf główne drzewo TEX-owe, zawierające makra itp.,
$TEXDIR/info podręczniki w formacie GNU info,
$TEXDIR/bin/$PLATFORM binaria

Można uniknąć stosowania „share/” przed katalogiem texmf, ponieważ $TEXDIR/share/texmf
i $TEXDIR/texmf są wykrywane automatycznie przez skrypt configure. W przypadku wybrania innego
katalogu, trzeba wyszczególnić ten katalog przez parametr --datadir skryptu configure.

Jeżeli nie chcemy używać katalogu $PLATFORM (tj. umieścić binaria bezpośrednio w $TEXDIR/bin),
w wywołaniu skryptu configure należy użyć parametru --disable-multiplatform.

Więcej dostępnych parametrów (np. pomijanie pakietów opcjonalnych, takich jak Ω czy ε-TEX) można
zobaczyć uruchamiając ./configure --help.

8.3. Uruchamianie make
Po upewnieniu się, że nie jest ustawiona zmienna powłoki noclobber, należy napisać

> make world

i . . . zaparzyć sobie kawę.
Mogłoby też być użyteczne zapisanie w pliku .log całego procesu kompilacji:

> sh -c "make world >world.log 2>&1" &

Zanim stwierdzimy, że wszystko jest w porządku, warto sprawdzić czy w pliku .log nie ma komunikatów
błędów (kiedy polecenie zwraca kod błędu, GNU make zawsze używa sekwencji „***”) i sprawdzić czy
utworzone zostały wszystkie binaria:

> cd /usr/local/TeX/bin/i586-pc-linux-gnu
> ls | wc

Oczekiwanym rezultatem jest 242. Polecenie make world jest równoważne z make all install
strip. Jeśli do uruchamiania make install potrzebne są specjalne uprawnienia, można uruchomić
dwie oddzielne sesje make:

> make all
> su
> make install strip

8.4. Końcowe kroki konfiguracyjne
Należy uaktualnić zmienną PATH o nazwę katalogu zawierającego właśnie zainstalowane binaria
(np. /usr/local/TeX/bin/mips-sgi-irix6.3); podobnie postąpić trzeba z MANPATH i INFOPATH
i dołączyć do nich odpowiednie nazwy podkatalogów, tj. $TEXDIR/man oraz $TEXDIR/info.

Program texconfig pozwala na ustawienie domyślnych wzorców przenoszenia wyrazów, rozmiaru
papieru, poleceń do druku, trybu METAFONT-a itd. Polecenia tego użyć można interaktywnie. Aby
zobaczyć jakie funkcje program udostępnia wystarczy napisać

> texconfig help

Przykładowo, jeżeli nie używamy formatu A4, możemy ustawić jako format domyślny „lettersize”
pisząc:

> texconfig dvips paper letter
> texconfig xdvi paper us
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9. Zakończenie
Niniejsza edycja TEX Live została opracowana przez Sebastiana Rahtza przy głównym współudziale:
Fabrice Popineau, który niezmordowanie przygotowywał pakiety dla systemów win32 (szczególnie setup!)
i wniósł wielki wkład w formie pomysłów, porad i kodu oraz Staszka Wawrykiewicza, który sprawdzał,
modyfikował i testował dystrybucję, a także koordynował przygotowanie polskich pakietów.

Kaja Christiansen odegrała wielką rolę nieustannie rekompilując programy na różnych platformach
uniksowych. Vladimir Volovich wielokrotnie czyścił pliki źródłowe i wprowadzał wiele ulepszeń. Gerben
Wierda wykonał wszystkie prace związane z systemem MacOSX.

9.1. Podziękowania
Szczególne słowa podziękowania za dawniejszą i aktualną pomoc należą się:

• Niemieckiej Grupie TEX-owej (DANTE e.V.), która udostępniła komputer, na którym przygoto-
wywano niniejsze wydanie; a w szczególności Rainerowi Schöpfowi i Reinhardowi Zierke, którzy
opiekowali się tym komputerem oraz prezesowi DANTE, Volkerowi Schaa, który koordynował
produkcję płytek w wydawnictwie Lehmann’s;

• Firmie Perforce, która udostępniła bezpłatną kopię świetnego oprogramowania do zarządzania
zmianami w przygotowywanej dystrybucji;

• Karlowi Berry’emu, za rady, zachętę i (oczywiście) za opracowanie oryginalnej wersji dystrybucji
Web2C;

• Mimi Burbank, która umożliwiła dostęp do wielu różnych komputerów Florida State University
School of Computational Science and Information Technology, na których można było kompilować
TEX-a. Ponadto Mimi, kiedykolwiek poproszona, działała jako najlepszy królik doświadczalny;

• Thomasowi Esserowi, za wspaniały pakiet teTEX, bez którego TEX Live z całą pewnością by
nie powstał, a także którego stała pomoc umożliwiła uczynienie z tej dystrybucji coraz lepszego
produktu;

• Eitanowi Gurari, za program TeX4ht wykorzystany do tworzenia tej dokumentacji w wersji HTML,
a w szczególności za niezmordowaną pracę nad jego ulepszaniem i błyskawicznie wykonywane
poprawki;

• Petrowi Olšákowi, który koordynował i sprawdzał przygotowanie czeskich i słowackich pakietów;

• Olafowi Weberowi, za cierpliwe pielęgnowanie Web2c;

• Grahamowi Williamsowi, za pracę nad katalogiem pakietów.

Janka Chlebiková, Erik Frambach, Fabrice Popineau, Volker Schaa, Petr Sojka, Staszek Wawrykiewicz,
Gerhard Wilhelms i Ulrik Vieth tłumaczyli w różnych momentach dokumentację na ich rodzinne języki.
Ponadto sprawdzali oryginalną dokumentację oraz zgłosili wiele cennych uwag i poprawek.

9.2. Historia
Dystrybucja TEX Live jest wspólnym przedsięwzięciem wielu grup Użytkowników Systemu TEX z:
Niemiec, Holandii, Wielkiej Brytanii, Francji, Czech, Słowacji, Polski, Indii i Rosji oraz grupy
międzynarodowej TUG (TEX Users Group). Dyskusje nad projektem rozpoczęły się pod koniec 1993
roku, kiedy holenderska Grupa Użytkowników TEX-a rozpoczęła prace nad swoim 4AllTEX CD-ROM dla
użytkowników MS-DOS. W tym też czasie pojawiły się nadzieje na opracowanie jednego CD-ROM dla
wszystkich systemów. Projekt taki był wprawdzie zbyt ambitny, ale zrodził nie tylko bardzo popularny
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i uwieńczony dużym powodzeniem projekt 4AllTEX CD-ROM, a także spowodował powstanie Grupy
Roboczej TUG ds. Standardu Katalogów TEX-owych (TEX Directory Structure), określającego w jaki
sposób tworzyć zgodne i łatwe do zarządzania zestawy pakietów TEX-owych. Końcowy raport TDS
został opublikowany w grudniowym numerze TUGboat-a, i jasnym się stało, że jednym z oczekiwanych
rezultatów wprowadzenia tego standardu mogłaby być modelowa struktura na CD-ROM-ie. Niniejszy
CD-ROM jest bezpośrednim rezultatem rozważań i zaleceń Grupy Roboczej ds. TDS. Jasne także było,
że sukces 4AllTEX CD-ROM pokazał, że użytkownicy Unixa także wiele by zyskali, mogąc korzystać
z podobnie łatwego w instalacji/pielęgnacji i użytkowaniu systemu. Było to jednym z celów projektu
TEX Live.

Projekt przygotowania nowego, opartego na standardzie TDS CD-ROM, zorientowanego na systemy
Unixowe, rozpoczął się jesienią 1995 roku. Szybko zdecydowaliśmy się na wykorzystanie teTEX Thomasa
Essera, ponieważ oferował on wsparcie dla wielu platform i został zaprojektowany z myślą o przenośności
pomiędzy różnymi systemami plików. Thomas zgodził się pomóc i prace rozpoczęły się na dobre
na początku 1996 roku. Pierwsze wydanie ukazało się w maju 1996 roku. Na początku 1997 roku
Karl Berry udostępnił nową, poważnie zmienioną wersję swojego pakietu Web2C, zawierającą prawie
wszystkie funkcje wprowadzone do teTEX-a przez Thomasa Essera. W związku z tym zdecydowaliśmy
się oprzeć drugie wydanie CD-ROM na standardowej bibliotece Web2C, z dodaniem skryptu texconfig
z pakietu teTEX. Trzecie wydanie CD-ROM było oparte na Web2C wersji 7.2, przygotowanej przez Olafa
Webera. W tym samym czasie została przygotowana nowa wersja teTEX-a i TEX Live udostępniał prawie
wszystkie jego nowe funkcje. Czwarta edycja była przygotowana podobnie, wykorzystując nową wersję
teTEX-a i nową wersję Web2C (7.3). Wtedy to też zainaugurowano kompletną dystrybucję dla Windows.

Edycja piąta (marzec 2000) zawierała wiele poprawek i uzupełnień; zaktualizowano setki pakietów.
Szczegóły zawartości pakietów zostały zapisane w plikach XML. Główną zmianą w TEX Live5 było
usunięcie programów, które nie miały statusu public domain. Zawartość całej płytki powinna odpowiadać
ustaleniom Debian Free Software Guidelines (http://www.debian.org/intro/free). Dołożyliśmy
wszelkich starań aby sprawdzić warunki licencyjne pakietów, ale bardzo prosimy o zgłaszanie zauważo-
nych pomyłek.

Szósta edycja (lipiec 2001) zawierała aktualizacje całego materiału. Główną zmianą było wprowa-
dzenie nowej koncepcji programów instalacyjnych: użytkownik ma obecnie możliwość dokładniejszego
wyboru potrzebnych zestawów i pakietów. Zestawy dotyczące obsługi poszczególnych języków zostały
całkowicie zreorganizowane, dzięki czemu wybór jednego z nich nie tylko instaluje potrzebne makra
i fonty, ale także przygotowuje odpowiedni plik language.dat i generuje podstawowe formaty (latex,
pdflatex) ze wzorcami przenoszenia wyrazów dla danego języka.

TEX Live 7 (2002) zawierał oprogramowanie po raz pierwszy dla MacOSX i, jak zwykle,
aktualizację wszelkich programów i pakietów. Ważnym zadaniem, które wykonano, było ujednolicenie
plików źródłowych programów z dystrybucją teTEX. W programach instalacyjnych wprowadzono
możliwość wyboru bardziej ogólnych, predefiniowanych zestawów pakietów (m.in. dla użytkowników
francuskojęzycznych oraz polskich). Nowością było także wprowadzenie procedury aktualizacji map
fontowych dla Dvips i Pdftex podczas instalacji oraz doinstalowywania pakietów fontowych.

W 2003 r., wraz z napływem aktualizacji i dodatkowych nowych pakietów, okazało się, że TEX Live
nie mieści się na pojedynczym CD-ROM-ie. Zmuszeni byliśmy podzielić TEX Live na trzy dystrybucje,
które opisano powyżej w części 2.1 na str. 4. Ponadto:

• na życzenie „LATEX team” zmieniono standardowe użycie programów latex i pdflatex – obecnie
korzystają one z ε-TEX (patrz str. 5);

• załączono nowe fonty obwiedniowe Latin Modern, które zastępują m.in. fonty EC (zawierając
komplet znaków europejskich), szczególnie do tworzenia poprawnych plików PDF;

• usunięto binaria dla platformy Alpha OSF (poprzednio usunięto także binaria dla HPUX), niestety
nie udało się znaleźć osób chętnych do wykonania kompilacji;

• zmieniono instalację w systemach Windows, wprowadzając po raz pierwszy zintegrowane środo-
wisko pracy oparte na edytorze XEmacs;

http://www.debian.org/intro/free
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• potrzebne programy pomocnicze dla Windows (Perl, Ghostscript, ImageMagick, Ispell) instalowane
są obecnie w strukturze katalogów instalacji TEX Live;

• mapy fontowe, wykorzystywane przez programy dvips, dvipdfm oraz pdftex, generowane są obecnie
w katalogu texmf/fonts/map;

• TEX, METAFONT oraz METAPOST wczytują obecnie domyślnie tablicę przekodowań cp8bit.tcx,
o ile nie wyspecyfikowano innej w wierszu poleceń bądź bezpośrednio w pliku; zmiana ta
(dosyć dyskusyjna – przyp. tłum.) pozwala wypisywać komunikaty na ekranie i w pliku .log,
a także w operacjach \write w ich reprezentacji 8-bitowej, zamiast tradycyjnej notacji ^^;
w TEX Live 7 eksperymentalnie wprowadzono zależność przekodowania wyjścia programów od
systemowej strony kodowej, obecnie ten pomysł zarzucono; w przyszłych wersjach planowane jest
bardziej skuteczne rozwiązanie opisywanych problemów;

• znacznie zmieniono niniejszą dokumentację (choć zdajemy sobie sprawę, że nadal nie jest ona
doskonała);

• wreszcie, ponieważ numery wersji kolejnych edycji mogły wprowadzać w błąd, postanowiliśmy
identyfikować edycje TEX Live zgodnie z rokiem wydania.

9.3. Przyszłe wersje
Niniejszy CD-ROM nie jest doskonały! Planujemy wydawanie go raz na rok i chcielibyśmy żeby zawierał
jeszcze więcej pomocnej dokumentacji, więcej programów użytkowych, lepsze programy instalacyjne
oraz (oczywiście) stale ulepszany i poprawiany katalog makr i fontów. Zadanie to jest wykonywane
przez ciężko pracujących ochotników, poświęcających na to wiele swojego wolnego czasu. Wiele jeszcze
pozostało do zrobienia. Jeżeli możesz pomóc, nie zastanawiaj się i przyłącz się do nas.

Poprawki, wskazówki i uzupełnienia dla przyszłych wersji powinny być przesyłane na adres:

Sebastian Rahtz
7 Stratfield Road
Oxford OX2 7BG
United Kingdom
tex-live@tug.org
http://tug.org/texlive

Uaktualnienia, ogłoszenia i wskazówki będą dostępne na stronie http://www.tug.org/texlive.html.

mailto:tex-live@tug.org
http://tug.org/texlive
http://www.tug.org/texlive.html
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